MacBook Pro Essentials

MacBook Prg at a glance
Take a tour: 14-inch and 16-inch MacBook Pro

Maote-
This gude is for the curenty shising MacBook Pro model s, If you're rot sure which modd you have or wart to find irformation and documertation for

other models, see the Apple Support aride ldent fy your MacBook Pro miodel

Thes 14-inch and 16-inch MacBook Pro model s have the following features. Mot dl features are available on al MacBook Pro models.

MagSafe 3 Headphone jack

- bo i
M

IThunderbolt 4 (USB-C)

fagSafe 3 port:
Flug inthe included USB-C Fower Adapter to recharge the MacBook Pro battery. The indicator Eght glows amiber when thes battery needs 1o be

charged, and green when it's fully charged. Clrarges your battery qui ckliy—up to 50 percertin altolt 30 mirutes —on the 14-indh model withthe S6VY
LISB-C Power Ad apter, and on the 16-inch modd with the 1400 USB-C Power Adapter.

Thunderboit 4 (USB-C) ports”
Transfer data at Thunderizoht speeds {Lip to 40 Gizps), conrect to a d splay o projector, conrect 1o USB 4 peripheras, and more. The ports candso

charge: devices, such as an iPhone or a rechargedle trackpad or keyiooard.

3.5 mm headphicrie jack:
Plug in stereo headphores or exterral speakers 10 listen to your favorite music or moviess. Your MacBook Pro supports the Lse of high-impecance

headphones without an additional headphone amplifier.



SDXC card slot, HOMI

Thunderbolt 4 (USB-C)

SDXC card slot:
Transfsr photos, videos, and data 1o and from your MacBook Pro, with sugoort for high-cagacity SD 4.0 cards.

KD part:
Conrectyour MacBook Pro to a TV or external display. See Use an extermal display with your MacBook Pro

Touch ID
1080p FaceTime HD camera, [power button)

Microphones |Force Touch trackpad

1080p FaceTime HD camera.

Make FaceTime video calls or take pictures ard video. The camera system prov des high-guLaity video and better lowight performance. If the green
indicator light mext to thes camera is glowing, the camerais on SeeFaceTime

and Usethe built-in camera on Mac

inthe macOS User Guides.

Studio-Quality Microphones:
Thre& MiCrophones With high 5iIGNAI-o-NoiSeE rati 0 and d reCt oNAal iL€aMforMinNg deliver Sa3er-Clear audio for vd eoConferertirgand pone calls, as well
as high-guality voice recordings for audio tracks, podcasts, and voi Ce mamos

Speakers,
The high-fidelity six-speaker sound system cons sts of two pairs of dual force-cancaling woofers and iwo twseter s, Erjoy a robuistand Figh-auality
audio experience, induding Spatid Audio sugoort for videos and songs with Dolioy Atnos.

Touth 1D {the DOwer butfon);

Press 10t on your MAcBook Pro (oF just lift the lid or fxeSs any key). A MEtalic 1im rrg g des your fingertohe Tolch ID S8NSor that aralyzes your
fingenzrirt When you first start up or restart, you need 1o login by tyjzing your password. To lean more abolt how to Lse Touch ID, see Magic
Keyoard for MacBook Pro

Force Touch trackpad:
Cortrol your MadBook Pro with gestures. Tre ertire frackpad suface acts as a button so you can easiy click anywhere, For more about using
gestures, sse MacBook Pro frackpad

Take a tour: 13-inch MacBook Pro
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Note:
This gude is for the curently shipsing MacBook Pro model s, f youfre rot sure which modd you have or wart to find irformation and documertation for
other models, see the Anple Support artide ldenti fy your MacBook Pro miodel

Thes 13-inch MacBook Pro Fas the folowing features. Not dl features are availasle on dl MadBook Pro models.

w
Thunderbelt | USB 4

L]
Thunderboit 7 L1SE 4 port:
Charge your comauter, transfer data at Thurderbdt speeds {up to 40 Giogs), cormmect to a dsplay or projector, USB 4 peripherd s, and more. The ports
can A50 charge devices, such asaniFad or a rechargeable tracksad or keyboard.,

= S 1

Headphone jack

3.5 mm headphicre jack:
PILg in steren headphores or exterral speakers 10 listen 1o your favorite mus ¢ or movies, Use high-impedance headohones without a digita-to-ard og
corwerter oran amg ifier.

FaceTime HD Touch 1D
Touch Bar camera, (power button)
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Microphones l Force Touch trackpad

Microphones:
Fecord live music, make conference cals, and mix aud o onths go. Tre three-microphons array crthe MacBook Pro divers siudio-guality recordings
with high signal-to-noise ratio and directional beamforning.

Speakers:

The Stere0 SPEaErs wWith high dyNamic range sUBHort Spat d Audio. With Spatial Audio, you Can enjoy an iMMESive, theater-like ervirormert while
watching videos with Doloy Atmnos, rock outasifyollre in the front row wien listening to songs on&pple Music, or feel as if youlre in he roomwith
your friends and family while on FaceTime,

Touch Bar:

The Touch Bar at the top of the keyboard dynamicaly adapts to e app you're using. Tre Toudh Ba is an extersion of the keyooard —it preseris
irtutive shortcuts and application controls, whenand where you need trem You can use familiar gestures like swipe and 1ap in tre Touch Bar. See
Magic Keyiooard for MacBook Pro

FaceTime HD carmera:
Make FaceTime video calls of take picturesard video. If the lig-tis g owirg, the camerais om. Ses FaceTime
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and Use thes blilt-in camera on Mac
inthe macOSs User Cuide.

Touch 1D (the power bution).
Presss to turn on your MacBook Pro (o just lift thelid or press any key). ¥when you first start up or restart, you néed to 1og inby typing your password,
To |garn more akbout how to Lse Touch ID, seg& Magic Keyboard for MacBook Pro

Force Touch trackpad:
Cortrol your MadBook Pro with gestures. Tre ertire trackpad suface acts as a buton so you can easly click anywhere. For more about using
gestures, see MacBook Pro trackpad

What'’s ncluded with your MacBook Pro

To use your MacBaook Pro, you need two accessor esind uded in e box—a cable and ore of the power adasters listed below.

Accessory Descrption

USB-C Charge Cable:

For 13-inch MacBook Fro.

To charge your MacBeok Pro, connect one end of the USBC Charge Cable toany Thundertolt ort cn your
MECBEDK Pro, 8nd the otherend to the inciLded power acaptear.

USB-C to MagSafe 3 Cable:

For Y4-inch aid 16-inch MacBook Fro.

Tn charge yeur MacBeok P, connect one end of the USBLC to MagSate 3 Ceble 1o tie MagSafe 3 port on yoLr
MacBook Pro, 3nd the otherend to the inciLded power adarter. When you first connect the cable to MacBeok
Pro, A battery status indicator on the connector starts £0 gicw: dreen 10r fLIY Charged OF gmiber for charging.

B87W USB-C Power Adapter:

For 13«inch and Ya=intd MdacBadk Fro,

Afterthe power adapter is connectad, fullly extend the slectricd prongs on the AC plug, and pugihne adapteririo
an AC power cLklet.

AC plug

W USB-C Powel Adaptel:

For 18-inch MacBonk Pro, Optiong! for 14=inch MarBook Fro.,

Atterthe power adarter is connectecd fully extend the slectricd prongs on the AC plug, end plgihe adapteririo
an AC power cutlet. The S6W LUSB-C Fower Adapter fast charges the 14-inch MacB ook Pro up fo 50 percent in

abolk 30 minutes.
AC plug

140W USB-C Power Adapter:

Optional fol 16-inc) MacBook Fro,

Afterthe power adapter is connectecd, fully extend the electricd prengs onthe AC plug, and plug ihe adapterirto
an AC power cLitlet, The 140WW USB-C Fowear Adarter fast charges MacBcook Pro 10 approximately 50 percert in
Sb0Lt 30 MiNUtes.

AC plug

Other adagters and accessones are sold separately. Wisit asple.com
s your local Apple Store, or other resel ers for more irformation and availability. Revi ew the dooumer-tation or check with the manLfacturer to rmake sure you

choose the right product.

Magic Keyboard for MacBook Pro
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The: Magic Keyboard with Touch ID has built-in features that make it easy fo enter emnoji, switch keyboard larguages, lock your MacBook. Pro, and perform
many system functions with the touch of a key. Whenyou set up Toudh 1D, you can uses your fingengrint 1o Lnock MacBodk Pro; quicky lock yolr screen;
or make purchases from the Aoz Store, Aople TV app, and Agsle Books, ard on wessites Lsing Apple Fay.

Touch ID (power button)

Funetion (Fn)/Globe key

Set up Touch ID.
Youl can set up Touch ID during setup, o at a later timein Touch ID & Password in System Settings
. For more information asout Touch 1D, sees Set up your MacBook Pro

Turn on your MacBook Pro.
Lift theslid, press Touch 1D {the power bution), or press ary other key.

Use Touch ID.

After you set Us Touch ID, when youl start up or restart the complter, yod reedtolog in by tyiping your password. After inrid login, whenever you're asked
for your password in the same session, you can just dace your finger ligh-tly on the Touch ID sensor to autherticate You can also Lse Touch ID to rake
onling purchases securaly with Apsle Pay, For more: informati on about Ai5sle Pay, see Uses Apple Pay on your Mac

Lock your MacBook Pro.
Press Touch 1D to gu ckly lock your screen.

Turn off your MacBool Pro.

To turm off your MacBook Pro, choose Apple menu €

= Shut Down, To put your MacBook. Pro o slesp, choose Asde mau @
= Sleep.

Use function keys on your 14-4nch and 16-inch MacBook Pro.
The function keys on the top row of the 14-inch and 16-inch MacBook Pro provide shortcuts for these common systemfunctions

L]
Brightness (F1, F2):
Press ©
or <
10 decreases of increase the rightress of the screen.

Mission Controf (F3);
Press 20
1o view what's running on your MacBook Pro, including all your s3aces and open windows.

Spottight Search (F4);
Press Q
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to open Spetlight and ssarch for somesthing on your MacBook Pro.

Dictation/Sir (F5);

Press O

to activate dictation—you can dictate text wherever you can type (for example, in Messages, Mal, Pages, and oter agos). To activate Sir, press ard
hold &,

thesn immedi ately speak wour request

Do Not Disturb (F6);

Press &

1o tum Do Mot Distudz on or off. When Do Mot Distunz is ony, you wont see or hear rotifications on MacBook Pro, but you can view themlater in
Motification Certer.

Media (F7, F8, F8):

Press <<

10 rewing, il

to day o pause, or BB

to fast-forward a sorg, movi e or slideshow.

Muste (F10):
Press o
to mute the sound from the built-in speakers or 25 mm headphone jack.

Volume (FTT, F12);

Press

or <)

1o decrease or increase the volume of sound from the built-in speakers, 3.5 mm headphone jack, or Bluestooth audio device.

Note,

Function keys can perform actions in specific apos or may have alternative functions—for example, the F11 key can hide all open windows and showy tre
desktop. To frigger the altermative function associated with a key, press and hold the Function (Fri/Gicbe key @

while you press a furction key.

Use function keys on your 13-inch MacBook Pro.
The Touch Bar o the: 13-inch MacBook Pro alsohas traditiona funclion keys Press and hold the Function Fr)/Glotse key @
o display function keysinthe TouchBar

Use the Touch Bar on your 13-inch MacBook Pro.
All systemn functions for your 13-inch MacBook Pro ae located onthe Toudh Ba. Use & Toudh Bar for tese common functions:

]
Brightness buttoris.
Press @
or 38
10 decreases of increase the rightress of the screen.

Mission Controf button:
Press 20
1o view what's running on your MacBook Pro, including all ¥our 83aces and Opsn windows.
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Laurchpad buttory:

Press 535

to open Launchypad

and instartly see dl the apss on your MacBook Pro. Click an aigo 1o asenit.

Keybcard ifurminationt buttors.

Press 10

or 2%

to decrease or increase the borightress of the keyboard.

Media buttons:

Prass <4

1o rewind, 11

to play or pause, or PP

1o fast-forward a sorg, mov g, or slideshow

Muste Outton;
Press ¥
to mute the sound from the built-in speakers or 3.5 mm headphone jack.

Volume buttons:,

Press 4

or 1))

10 decrease of increaseé the volume of sound from the built-in speakers, 3.5 mm headphone jack. of Bluetooth audio device.

You can also customi ze the Touch Bar on your 13-inch MacBook Pro for differert apos. See Fow in Customize the Touch Bar on the 13-inchMacBook
o]

Touch Bar Touch ID (power Button),

|:—'unction (Frn}{Globe key

Use gmoji or switch keyboard languages.

Press the Function (Fr)/Glokse key 48

fo switch To a different keyboard. Press &

repeatedly to cycle through emoji options or olt-er languages you specify in Keyboard settings, or press twi ce guickly to start dictation §f you tumed on
Dictationin Keyboard setlingsh

Adjust keyboard setlings.

To specify options for your keyiooard and the Function (Fn)/Globe key & ,

open System Settings, click Keyboard inthe sideba, and choose options 1o change your keyboard or input SouUrce, Ehow emoji and symiois, start
dictation, or define functions.

Learn about keyboard short cuts,
Youl Can press key comid nations 10 do things on your MacBook Pro that you'd normally do with a trackpad, mouse. or other device. For exampde, press
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Command-C tocopy selected fext, then click where you want to paste the text and press Conmard-V. For a listof commonly used shortzuts, see
Keyizoard shortcuts onyouw Mac
. K you're new to the Mac, you migt-talso e interested in Areyou rew to Mac?

Use the Touch Bar on MacBook Pro

The: Touch Bar onthes 13-inch MacBook Prois integrated imto many macOS apps to give you hardy g-ortauts for the tasks you do mcst, ibased on your
currertapp and activity, Use familiar gestures—like t3o and swipe—in t2 ToLch Ba while you work.

Thes bLttors at the ight end of the Touch Bar are the Control Strip—you use themto expand o cd lapse tre Control Strip, change the brichtness ard
volume, or acvate Sin. The otrer buttons in the ToLch Bar depend onthe ai33 yoldre LSirg.

Tap to expand
[ the Control Strip,

IThese buttons are
always available.

Expand or collapse the Control Strip.

Frequently Used system cortrols, like volurme and brig-tress, are located in the Cortrol Strip on the rigt s de of the Touch Bar. Tap (
1o expand the sinp, then tap buttons or sliders for the settings you wart to change Tas ®

when you finish, or igavs the Cortrol Strip open o kegp the buttons available.

Custornize the Cortrol Strip.

Go to System Setings

, Clige Keyboard in the sideioar, dick Touch Bar Setlirgs, then click Customize Control Strips Drag contrel 5 to the bottomn of your scregn ard into the Touch
Barto add them. In Keylzoard setfings, you can also select optiors for what the Control Strip d s ays—Tfor example, furction keys or desktop spaces

v s St s o LAt o st e P 300

Display the function keys.
Press and hold the Function (Fh) key tO display the function keys F1 throuch F12 in the TolCh Bax, 1en ap a furction puittn touse it

Tap instead of type.

In apps where you compose text, ike Notes, Messages, TextEdit, and Mal, the Touch Bar can display typing suggestions to help you save time by
preserting words and emoj you can fao instead of type. Tap ()

inthe Touch Bar to see typing suggestiors, if they’re not already showing.

Note:
Tyoimg suggestions may not be availakie in all 1arguages or in al areas.

Express yourself with emoji.
IN S0Me 30105, you can cho0se an emojiinstead of words for afun way to make your point. Tap @
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1 display the emoji. Swipe toscroll through optiors, organi Zed by categorny, such as''Frequerty Used,” “Smieys & Pecple,” “Travel & Places. ™ and more.
Tap 1o select the emoji you wart.

EBVORJ000DBVTEBQRLY E

Explore and experimernt.

Tap arouind to 568 what you can accomplish guickly ard efficiently. s often easier to tap the Towch Barthan 1o click or sdect ilems onscresn in ordar to
accomplish a task or apply a seting. For examid g, open Caculator and do quids calculatiors with the number keys and the furctions onthe Touch Bar—
ro mMore meving your pointar, dicking, and tyoing orsoreen.

Keep using the Tolch Bar 1o find e best ways 1o achieve the resutts you want. Move seamiessly between the Tolch Bar, yolr keyboard, and the tracksad
1o gat the job dore See Apos onyour MacBook Fro
and the sections for each app forimformation about their Touch Bar features,

Learn more.
See Use the Touch Bar on Mac
irmthe macOS User Guide.

Customize the Touch Bar on the 13-inch MacBook Pro

In e Finder and in aops such as Mail
and Safar
y ¥OU Can customize the buttons in the Touch Bar for that asp. Chooss View » Customize: Touth Bar 1o add, delele, or rearrange temsinthe Touch B

When you're customizing the: Teuch Bar, the lsuttors jiggle and a Dore iutton apgzears. For example, Here's the Calculator Touch Bar, reacy 1o be edited

Add buttons to the Touch Bar.
Drag controls to the bottom of your scregn and into the Touth Bar 1o add them.

B [

When you finishy click Done on the screen or inthe ToLch Bar

Rearrange buttons in the Touch Bar.
Whie customizing the Touch Bar, drag buttons o anew location. Yhen you finish, clids Done onthe screenor in t-e Touch Bar

Remove buttons from the Touch Bar.
While customnizing thes Touch Bar, drag abutton fromthe Touch Bar to the screen to remove it When you firishy clide Dore on the screen or in the Touch
Bar.

MacBook Pro trackpad

Yol can do a lot on your MacBook Pro using simple trackisad gestures —scroll through welasages, zoom in on documerts, rotate ptotos, ard more. With
the Force Touch trackpad, pressure-sersing capabilities add arother level of interactivity. The trackpad provides feedback—when you drag or rotate
objects, you feed a sublles vibration when they’re digred, dlowing you to work with greater precision. For examples of force touch options, see the Apple
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Supior article How to use the Force Touch trackpad

Here are some common gestures:

Gesture Action

Click:
Press anywhere ON the trackpad. OF erakd & “Tap t0 ¢l ok in Trackpad Settings, and simply 1ap.

Force glick:
Click and #1en press deeper. You can Lse force dlick tolook up more irformaticn=click aword 1o see its
definilicn, or an address to see apreview thak youl can ppen in Mares-

Secondary click (that is, right-click):
Click with two fingers 10 ooen shortcut menLs If “Tap to Click is enabled, tapwith two fingers. On tre keyboard,
press the Control kKey ard click e trackpad.

Two=fihger scroll:
Slicke two firgers Up or down to scroll.

Pinch to zoom:
Pinch yCLr trumb and finger open or dosed to Z00min or cUt of photss and webrages.

Swipe to navigate:
Swipe left or right with two fingers toflip through webpages, deoLments, and more—like tuming a pegein a
alee] 4

Open Launchpad:
CLiCky OEN 8018 N Launchpad
. Pinch dosed with four or five fingers, fhen dickan app 1o open it

Swipe betwesn RS
To switch from one fLl=screen app to enother, swi pe [eft or right wit three o foLr fingers.

Tip:
If youtind youlre foree clicking whenyou dortirtend to, try adjustng the click pressure to afirmer setting in Tradepad Settings. O chance the “Look b &
data detectors” option from the “Forces Click with ore finger? defalt setirgto “Tap with three fingers.”

Custornize your gestures.
InSysten Settings
, Clide Trackpad in the sidekar. You can do the following:

e Lgan more abolt each gesturs
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o Setthe dick pressure you grefer to uses

¢ Decide whether 1o use pressure-sensing features
e Cortrol the tracking speed

o CLstomize other trackpad featlres

Note.
f you would like 1o use a Bluetoot-® mouse or tackpad in addition to the trackpad on your MadBook Pro, learnbow to set it up at Use Bluestooth

accessores with your MacBook Fro

Charge the MacBook Pro battery

The battery inyour MacBook Pro recharges wherever the MacBook Pro is comected 1o power.

Charge the battery.
Conrect your MacBook Pro to a power outlet usirg the induded cald e and jsover adagter. To leam more alcout the adapster and cable that came with your
MacBook Fro, see What'sincluded with your MacBook Pro

Shiow battery status in menu bar.
Add anicon to your mearu bar 50 you can quickly seeirfxmat on about your battery and open Battery settings. In System Settings, click Contol Canter,
ther go 1o Battery on the right and elidk Shew in Meru Bar. You can a so choose to show battery parcertage in the meru bar

Custornize battery settings.
Yold Can set differert colions for yolr Battery iN System Settings

Qptimized Battery Charging.

This feature helps to reduee thes wear on your battery ard improves its | fespan by learring your daly chargrg roufire. It ddays crarging the bsattery past
80%% when it predicts that you'll be plugged in for an extended period of time, and aims to charge the batlery elore you unglug. I System Settings,
click Battery in thes sideizar, click @

oy Battery Health, then fum on Optimized Battery Charging.

Low Power Mode:
This gption reduces energy Lsage and increases attery life. THis s a good ot on for traval or when you're away from apower source Tor an extended
period of tine, In Systemn Settings. click Battery in t-e sidekar, tten dhoose fromthe optiors inthe Low Power Mode dropdown

High Power Mode:
Availalbe onthe 16-inch MacBook Pro. When High Fower WMode i s selected, your Mac dlows the fansto run at Figher speeds to maximize performance
during irtensive workdoads. In Syslem Setlirgs, diclk Battery in thes sidsbar, then choose from the oistions in the Hich Fower Mods drofcd own

Maote
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To customnize other advanced settings, like enablirg power nap, aLtomati c graptics switching, ard whenio wake for network access, dick Options in
Battery Settings.

To charge the batteng uee the MagSafe 3 port or any of the THunderbolt 4 (USB-C) ports onyour 14-irchor 16-inch MacBook Pro, or ary of the
Thunderbolt/ USB 4 ports enyour 13-inch MacBook Pro.

Note.

With the USB-C to MagSafe 3 Cable and optioral 140 USB-C Fower Adacter, you can fast charge thes 16-inch MacBcook Pro up 1o 50 percertin about
30 minutes. And with the USB-C to MagSafe 3 Casle and the S6vY USB-C Fower Adater, you can fast charge the 14-inch MacBook Pro upio 50 percert
irmabout 30 minutes.

Check the battery’s charge.

Lock at the battery status icon atthe right of the menu bar to see the battery level or dharging status. Or co to System Settirgs and click Battery in the
Sdekzar.

() ()
Charging Charged

Battery usage history.
Go to System Settings and click Battery to see your battery’s usace over the past 24 hours or e |ast 10 days.
ene T

9 Low pewer mode Neier &

B siri & Spotiight

Battery health Nl (D)
10 Privecy & Security
B oesviton & Dok Last 24 Haurs Last 10 Days
£ oispias Fully Chargad

L Wailpapar

Scroen Savar

=l

:

D) users & Groups

8 Fassaords Sereen On Usage

@) rtamor tcsaurts
W Game Cantar Jam
B watlet & Appl oy l [ l ' l
=20
) F g 12 : 8 a 127

[Z) keyboard
A Trackpad

G annars Dptions. 7
\zl) Printars & Scannars i 2

Conserve battery power.

To extend battery life ona given charge, you can reduce the display brighiness, close gsps and dsconnect perpheral devices you're not Lsing. In Systzm
Settings, Click Battery in the Sidehar 1o Change your powsr Settings. If Your MacBOook Pro iS in SI8S0 when 3 davice is Connected 10 it, the deviCe's battery
may drain.

Ledarn more,
For more information about

o The battery inyour Macg, including troubeshoot rg information, see the Agole Support article Gethels with your Mac lartop battey
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¢ How to monitor the kattery in your Mac or creck its condition, see Moritor your portable Mac computer’s battery
and Check the condition of your Mac notekook’s battery
inthe macOS User Guids.

¢ Charging issues with your power adacter, see the Appls Susport arickss I your USE-C power adapter isnt charcing your Mac laptop
and If your Mac isattery status is “Not Chargrg”

o The irtermal, rechargead e bbattery in your MacBook Fro, and for conservation and perfonrmance tips, see Agpe Lithium-ion Batteries

Adapters for your MacBook Pro
Thes following Apide adasters are avalabe 1o cornect your MacBook Pro 1o power, externd devices and disdays, ard more.

To see where your ports are located on your WlacBook Pro, see Take a four; 14-inch and 18-inch MacBook Fro
or Taksa tour: 13-inch MacBook Pro
. You can leam asout each ort, ard what it 1ooks like, with the Apple Sugport Artid e ldertify tre ports onyour Mac

Cable or Adapter Descrigtion

|
USB-C to USB Adapter:
Connect yollr MacBook Pro to standard U SB arcessones.

USB-C to Lightning Cable:
Connect your iFrcne or crer i0S or iPadOS device o yoLr MasBrok Profor syncing and chargirg.

| USB-C Digital Av Multiport Adapter:
Connect your MacBook Pro to 8 HDM digay, whils alsocornect ng 8 standard USE device and 8 USEs=C
charge cable fo charge your MacBcok Pro.

Connect directly fo the HOMI port cn the 1d-inch and 16-inch MacBook Pro.

| - USB-C VGA Multiport Adapter:
| Connect your MacBook Pro to a VEA projector or display, while also connectirg a standard USB device anda
USB-C charge cable to charge yolr MacBook Pro.

Thunderbalt 3 (USB-C} to Thunderbolt 2 Adapter:
Connect your MacBook Pro to Trunderbolt 2 devices The Thunderbolt 3 (USB-C) adapter can be Lsed with the
ThUNdertolt 4 Ports On YoLr MECECOK Pro.

Learn more,
Sae the Apoles Support artic & Adasters for the Thundércolt 4, Trunderoot 3, or USB-C port on your Mac

Adaters and other accessones are scld separately. Vit apde.com
» your local Apple Store. or other resellers for more irformation and availazility. Review the dooumertation or check with the manLfacturerto make: sure you
choose the right product.

Use Bluetooth accessories with your MacBook Pro

Using Bluetooth tecnology, your WlacBook Pro can wirelesdy connect with devices sudh as a Bl Letooth keyloard, mouse, trackpad, headset, jperpheral
devices, wearasle sport accessories, AirPods, and more.
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Pair a Bluetooth device.
Before you connect a Bluetooth device with vour Mac for the first time, you need to pair hem, In order to pair your Mac with a Blugtooth device, make sure
they are both turred onand rear each other. Be sure to review your Bluetooth device'’s documertation 1o makeé sure you've set up the device to pair.

Turn Bluetooth on or off.

Clids thes Conirol Certer icon'e

imthe menu kar, dick the Bluetooth iconf ,

thenclick the control to turn Bluetooth on or off. f you have the Bluetooth £

icon in your menu kar, you can dlick that and then tum the cortrol on or off. Your MadBook Pro comes with Bluetooth turned on.

Tip:
If youdon't see the Blustoothicon £
inthe menu bar, you can add it Ih System Settings, click Cortrol Center in the sideksar, then choose Show in Meru Bar for Bluetooihe

Comnect a Bluetooth device,

Tum on the device so that it’s discoveralbie, 1hen oen System Saettincs

and dick Blustooth Sdect ihe device inthe list, then dick Cornect. The device remains connected until you remove it. Corirol-click a device name fo
remove it

Wwhen a Bluetooth device is ipaired with yolr Mac, you can conrector discomect it using the: Blustooth £
icon in thesmenu bar.

Learn more,
Se=e Use Blustooth devices with Mac
irmthe macOS User Guide.

Use an external display with your MacBook Pro

The HOMI and Thunderbolt ports on your 14-inch and 16-irch MacBook Pro and the Truncerbolt ports on your 13-irch MacBook Pro support vdeo
outiBLt, S0 you Can CoNNEct an external display, A Brojector, of 8 high resolution Tv.

On your MacBook Pro with Apicle M2 Pro, you can cornect up to two exterral disgays in the followirg configuratiors:

¢ Connectone external display with up to BK resd Ltion at 60 Hz usirga Thunderkolt portard one externa display with Lo 1o 4K resol tion at 144 Hz
using the HDMI Eo.

¢ Connectup to two extemal disglays with up to 6K resolution at 60 Hz Lsing tre Thunderbdt ports
Yol can also conngct a sind & display with Us 1o 8K resollLtion at B0 kFz of up 10 4k resaiution at 240 Hez using the HOMI port,
On your MacBook Pro with Apple W2 Max, you canconnect up to four exterral digslays in tre followirg configuratiors:

o Connectup to three extamal displays with U2 to BK resolution at 80 k2 usirg the Thurderboltports ad ore extarrd display with up 1o 4K resdution at
144 Hz usirg the HOMI sort.

¢ Connectup to two extemal displays with wp o BK resolution at 80 Hz using the Thunderbdt ports ard, using the HOMI port, ether one external display
with up 1o 8K resolLtion at B0Hz or one exterra disslay with Lo 1o 4K resoltion at 240 He.

To learn more abolt using an 8K display with your MacBook Pro, see e Aople Support Article Use an 8K display wih your Mac

On your 13-inch MacBook Pro, you can connect one extanal display with up to BK resoltion at 60 Hz.

If you're not sure how many external disg ays your MacBook Fro sLpports, dreck your Techrical Specificatiors. Gpen System Setlings, doose Help =
MacBook Pro Specifeati ons, tren locate Display Support (you may reed to scrollk
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To s=e where your ports are located on your MacBook Pro, see Take a tour: 14-inch and 184nch MacBook Pro

or Take a tour: 13-inch MacBook Pro

. You can leam about each sort and what itlooks like with the Aple Support Article Idertify the ports on your Mac
, 8id make sure you haves the right adapters with Adaoters for your MacBook Po

Cornnecta VGA display or proje=tor:
Use a USB-C vGaA Multicort Adapier o correct the display or projector to a Thunderbd tport on your MacBcok Pro.

Caonnectan HDMI display:
Flug a cade from yolr HDIWIL display directly irto the KOl port on your 14-inch o 184 rch MacBook Pros Use a USB-C Digitd AV MU firort Adapter 1o
conrect the HDMI display to a Thunderbolt ¥ USB 4 port on your 13Hrch MacBodk Fro

Caornnecta USB-C display:
Connectthe display to a Thuncensolt jport on your MacBook Fro.

Note”

The: MacBook Pro can support ot Agple Pro Display XDR and Apple Studio Display. To set L, see he Appe Support arides Setup and use Apde Pro
Display XDR

and Set up and wse Appd e Studio Display

Use an adapter to connect a display.

If your display has a conmector that doesn't matth thes jsort you want to use, you may be akd e 10 Lse it with an adapter (sald separataly). Wsit apd ecom
, your local Apple Store, or other resellers for more irfomnation and availasility,. Review the digslay’s documentation or check with he display’s
manufacturer to make sure you choose: the right product. See Adaters for the Thunderzdt 4, Thu-dedbdt 3, or USB-C port on yvour Mac

Troubleshiooting.

To troubsleshoot an issue with an external disglay, seelf your extemal dsdayisn't detected or appears blurry onyour Mac

« K youre not sure how many exterma disglays your MadBook Pro sugsorts. chedk your Technica Specificaticns. Oppen System Setlirgs. then dhoose Helip
= WacBook Specifications, then locate Video Support (you may need to scrolll.

Use an Apple TV with AirPlay.

If youhave an HDIMI display comnected 10 an Apsie TY, you can use Airf ay 1o mirror your MacBock Pro 5Creen on your TY screen. See Use AirPay on your
Mac

for details.

Adjust and arrange displays.
After you connect an extemal display of projector, go to Disgdays in Systemn Settings
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10 58t how the displays are aranged, Choose which 1o LSS as yoll main display, ard adjust resolution K you want 1o mirror your screen, click he display
that you wartto act as a mirror, then choose the mirror otion from te *Use as” dropd own.

Get started

Set up your MacBook Pro

The first time your MacBook Pro starts up, Setups Asd start walks you through the s mple steps nesded to start using your newr Mac. You can respond to al
the romicts, or skip some steps and choose to comzlete them later. For examole, it might make sense to setus Saeen Time—which you can sat for
differert users—after inii d setup.

Setup Assistart guides you through the: following:

Set your country or region;
This sets the language and time zcre for wour Mac.

Accessibifity options.
View accessibi lity options for Vision, Motor, Hearing Gognitive abilities, or click Mot Now. To learn morey see Access ity onyour Mac

®

Accessibility
Accasalliry ST A0SAT YOUr M3 10yt ks W, WS £ U TR 30 W 33 Tl
=

2 Pl e
firichsetting up, and further custopize Fore Wt 1 System Prafereices. Ges what's svalebie i coth
of the catrgones bab

Vision Motor Hearing Cognitive

st Mo

Cornect to a Wi-Fi netwark:

Choose the network and erter a password, if necessary. {If youYe using Ethernet, you canalse choose Other Metwork Options.) To chance the retwork
| ater, giick the Yvi-Fi status icon =

inthe menu kzar, orin Systemn Settings

, click ¥Vi-Fi inthe sidekar, then choose a network a-d erter the password. You can also choose to turm Wi-Fi on or off Fere.

Tip:
After setup, if you dor't see the Wi-Fi status icon =
inthe menu kzar, you can add it Open Systern Settirgs, dick Cortrol Center in the sidekar, tren sd ect *Stow in Meru Bar™ for Wi-Fi.

Transfer information”
If you wart to transfer your data fom anothe computer now or later, see Transfer your data to your rew MacBook Pro
. i you're setting up a new computer and you haven't previously set 4z aMac, click Not Now in the Mgration Assistartwirdow.

Sign in with your Appfe ID:

Your 8pple 1D

consists of anemal address and a password. s the account you use for everytihing you do with Aggple—including using the &pp Store. Apde TV 8o,
Lople Books, iCIoud, Messages, and more. 15 best to have your own A5 e 1D and not share it 1fyou don't aready have an apple 1D, youd can Creals
one during sestup (it's free). Signin with the same Apple 1D

to use any Apple service, on ary device—whether it's your computer, iI08 device, iIPadOS device, or Apple Watch. See Apple ID on Mac
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Tip:
If youve already set Lp another device with macOS 12 or later, i0S 15 or later, PadOS 15 or later, you'll see a panel for express setup, Make This Your
New Mac. Express setus skips alot of the steps and uses the sefires stored inyouwr id oud accourt

Store fites in iCloLd:

With iCloud, you can store your contert—documents, photos, ard more—in te doud, and access it arywhers you go. Be Sure to sSicninwilh the same
Apple D on all your devices. To set this ojstion later, gpen System Settings and dlick "Sign in with your Apple 1D7in the sidebar, if you haven't already.
After you sign in, clidk your Apole IDIN the s debar, click iCloud, then salect the feature s you wart to Lse You can also choose to use iCloud Keychain
to savs your passwords duni ng setup. To find out mores, see Access your iCloud cortertt on your Mac

Screeft Time:
Monitor and get reports on the use of your computer. For options and details, see Screen Time on Mac

Enable Siri and “Hey Siri”:
You can turn on Sir ard "Hey Sin” (so you can speak your Siri reguests) durirg setua To enable “Hey Siri,” speak severd Siri commands wien
prompted. Tolgan how To tum on Sir and “Hey Sin” latar and for information about using Sin on your Mac, 588 Sif on your Mac

Set up Touch 10

You can add a fingergrirt o Touch ID during setus To set uz Touch ID later, or toadd additioral fingerprints, open System Settings, tren click Touch 1D
& Password in the sidebar. To add a fingerprint, click +
and follow the onscreen instructions,

You can also set options for how you want to use Touch ID on your MacBook Pro: to Lnlode your Mac, use Apple Pay {sse Use Apple Pay on your Mac
) purchase items onthe Apz Store Apple TV app. Apple Books, and welbsites, and auto-fil your password.

Tip:
If twvo or more users use the same MacBook Fro, gach Lser can add a fingerprint to Touch ID 1o gui ey unlock, authertcate; ard loginto the
MacBook Fro. Youcanadd up to thres fingenzirts per user accourt and a tota of fives firgenoints for all your MacBook Pro usér accounts

To learn more, sees Use Touch ID on Mac
inthe macOS User Guide.

Set up Apple Pay:

You can set up Aople Pay for ome user account on your MacBook Pro durrg setup Otter Lsers can still pay with Apple Pay, but trey must complete
thes jpurchase using their iProne or Apsle Watch that's been set up for Apple Pay (see Use Apple Fay on your Mac

3 Follovr the: omscreen promots 10 add and verify your card f you already usga card for media purchases, you might be prompted to verify this card
first.

To set Up Apple Pay or add additional cards|ater, gzen System Settirgs, then click Wa let & Aggple Pay. Follow tre onscresn prompts to set up Apde
Fay.

Nole:

The card issuer determines whesthesr your card is eligible To uses with Apple Pay, and may ask you 1o provide additional informationlo complete the
verification process. Many credt and debit cards can be Lsed with Aigsle Pay. For information abolt 8o ple Pay availability and currert credit card
i S5UErs, seathe Apple Supportartice apple Pay partidipat rg banks

Choose your logk:
Select Light, Dark, or ALto for your deskioo appearancs. If you want 10 charge the oo o yoll miake during setup, ooen System Setings, click
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Aopearance, then select an option You can Al S0 58t other appearance settngs, 8Jch ashighlight color oF sideba Icon 528,

Tip:
If you're newy 1o Mac, see Are you new to Mac?

inthis guide, Whats it called on nmy Mac?

inthe macOS User Guide, and the Apidle Supitort arti cle Mac tigs for Virdows switchers

Apple ID on Mac

Yolr &ppie IDis an accourt that lets you access all Apoie serv ces Use your Agsie ID to dowrioad ai5os from the Adp Storg access medain Asde
Music, Apple Podcasts, Apdle TV, and Apole Books; kesp your cortert L to date across devices using iCloud; set up a Family Sraring groug and more.

Youl can also use your Agdle ID o access other apps and websites {see Use Sign in with Apple on Wac
inthe mac05 User Guide).

Irmportant
If you forget your Apple ID password, you dom't need 1o areate a new Apple ID. Just dick e “Forgot App'e ID or password ?” link in the sign-in window o
retneve your password,

If other family memiars Lse ApiSle dev Ces, make Sure that gach family meamizer has thar own Apple DL You can eate Apd e ID accounts for your kids
and share purchases and SULSCriztions with Family Skaring, descrilbed later in this section

To view the services you can uses with vour Apple 10, see the Apple Susport article Where can | use my Apple ID?

All inone place.

Marage everythirg related to your Apidle IDin the same place Open Systemn Settings

on your MacBook Pro—your Az0le ID and Family Sharirg settings are at the top of the 5 debar. Te sign in with Apde 1D, if you haven’t dready, click “Sign
inwith your Agole 107 at the top of the sidebar.

Manage family members, parental
cantrols, purchases, and more.

TR Ashiey Fico

Update
account
infarmation

= Turn iCloud
——on or off.

- Manage
media
accounts.

o Astieys MacBook Pro

See all devices signed
In with your Apple 10,

Update account, security, and payment information.
In System Settings, click your Aople 1D inthe sidebar, ten select anitem to reviewy and update theyinfomnation associated with your acoourt.

Overview:
Lets you know if ¥our accourtis set 4o and workirg propery —if not, you see tips and notifications here.
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MName, Phone, Email;
Update the name and contact irformation assod ated with your Apple 1D, You can aso manace Apile emall newsletter subscrptions.

Password & Security:

Change your Apsle ID password, tum on two-factor avt-ertication

» 8dd o remove trusied phone Numbers, and generate verification codes 1o 5ignin 1o another device or iCoud.com
. Youcan dso manage which gops and webstes use Signinwith Agde. See Use Sign in with Apple

inthe macOS User Guide.

Payment & Shipping:
Manage the: payment methods affil ated with yvour Bpple 1D, ard your stippirg address for purchases from the Apple Store.

fClond:
Click iCloud, then choose which iCloud features you wish to tun on or off. When you turn on an iCloud featurs, your contert isstored in iCloud and not
|ocally on your Mac, so you can access any cortent onany device withi Cloud turred on and signed in wath the same Apple I

Media & Purchases.
Manage the: accourts linked to Apple WMusic, Apple Podcasts, Apide TV, ard 8od e Books; select purchasing settings; ard marage your suibscriptions.

See all your devices.

See all the devices linked to your Asple ID. You can verify that Find Wy [device

1istumed on for each one (see Find My

1. seethe status of iCloud Backup for aniOSs or iPadOS device, or remove a device from your accourt if you rolonger cwn t.

Family Sharing

With Family Sharing, you can set uo a family grous for Lo 1 siX members, THeN ¥0ou Can 8-are and manage purchasas, ard share dev celocations or mark
devices as lost inFind My. You can also manage how your children use their devices by creating Apple 1D accourts for your kids and set Screen Time limits
{see Screen Time onMac

1 To marage your family sharng settings, click Family in Systermn Settings

. To learn more, Sea the Apole Support artide Set Lp Family Sharing

Shiare purchases and storage with Family Sharing.

Up to six memicers of your family can share ther purchases from tre Spp Store, Agsle TV asp, Aigsle Books., and iTunes Stare, and share the same storage
plan—even if they 8ach LSe their own (CIoud 3ccourt. Yol can pay for family purchases with ONe Credit Card, While 3pprovirg your kids® Spending right
from your IMacBook Pro.

Account Recovery.
Add one or more people you trust 3s a recovery cortact or set L a recovery key to hels you reset your password a-d regain access 1o your accourt. Jlick
Password & Security, then dick Manage for Accourt Recovery.

Legacy Cortact.
Dessignate one or more persons as Legacy Cortacts sothey can access your account and personal informaticn after your death. Click Fassword &
Securnty, then click Manage for Legacy Cortact.
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Learn more,

To learn more abolt iCloud and Family Sharing, see Access your | Cloud contert on your Mac
and Manage a Famiy Sharing grous on Mac

imthe macOS User Guide.

Find your way around

Desktop, menu bar, and Help on your Mac

Thes first tHimg you see on your MacBook Pro is the deskiop,
where you can glickly open apps, search for arything ornyour MacBook Fro ard the web, organize your files, and mora

i.ﬂ;}‘ple e The desktop

|&DD menu

AT I A B

.lHeIp menu

Finder window Control Center
JMerlu bar l
i

System Settings

Tip:
Cartfind the poirter on the soreen? To magnify it temparari y, move your finger rapidly kback and forth on the trackpad. Or if yourve using amouses, slide it
back and forth quickly.

Menu bar.

The menu bar runs dong the toe of the screen. Use the merus on the left sde to choose commands ad perform tasks in aops The meru items dhange,
depending on which apk you're using. Use the icons onthe right s de 1o cornect to a Wi-A network, chedk your Wi-Fi status &,

open Cortrol Center &,

check your battery charge &,

searchusing Spoflight &,

and more.
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Tip:
You can change the icors that appear inthe meru bar. See Cortrol Certe on your Mac

Apple menu & .

Thes Apple menu contains fequenty used itemms ar-d always apioears in he Usper-left corne of tre screen. To open it click the Apsle icon & .

Appmenu.

Yol can have multiple asps and windows open at the same ime. The name of the app that’s active appears in bold to tre right of the Agocle menu @ .
followed by that app’s umigue menus. If you open a differert app or click an oppenwindow in a different asp, the rame of the app menu charges to that aoe
and the mernus inthe menu izar change aong with it. I you’re 1ookirg for a command ina menu and cam'tfind it checlk the aop menu to seeif the ago you
wart isactive.

Help menu

Helpo for your MacBook Pro isalways avalable inthe menu bar. To get hely, open te Frder in tre Dock, dick tr Help menuw, and choose macOs Help to
open the macOS User Guide. Or tyse in the search field and choose a suggestion, To get Felp for a specific aop, open the agp and clids Help inthe menu
bar. See Use the macOSs User Guide

M Finder File Bt View Go  Window | Helg
¥
Tipa for Your Mac
macO5 Help

Stay organized with stacks.

Youl can gather files on the desktop into stacks 1o keep them orgarized ingrouss oy kird, date, o tagl and 10 keep yolr deskios orderly. Toview what's
irside a stack, click the stack to excand its cortents, or place your pointar over a stack 1o view thumiznal inages of the fies. To cregte stacks on your
desktop, click the desktop, then choose View » Use Stacks. To see grouid ng opptions for your stacks, go to Miew = Group Stacks By and choose an option.
Then ary newfiles youadd to the desktop are automali caly sorted irtothe appropr ate stack. To leam more, see Use deskiop stacks on Mac

inthe macOS User Guide.

Learn more.
Seze Finder on your Mac

Finder on your Mac

Represerted by the blug iccn with the smiling face, the Finde is the home base for your Mac. You use it1o orgarize and access Amost everythirg on your
Mac, irduding documerts, images, movies, and any other files you have To open aFinder window, click the Fircer icon &

inthe Dock at thes bbottorn of thes screen. Foree click a file icon to guickly wiew its conterts, or force click a flename to edt it. See MacBodk Pro trackpad
10 lzam azout force clicking and other gestures.

For information about using the TolLch Bar for Fincer tasks, sees Use the: Firder with the Towch Baron your 134rch
MacBook Fro
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The Finder window.

Clige thes pop-up menu Button at the top of the Fircer window o charge Fow you view documerts a-d fdders. Viewthem asicors, in aiist, in hierarchical
columrs, oF ina gallery, The sidebar on the [Bft shows tre itemns you use often orwant 1o open guickly. To see al your documerts stored on iCloud Drive,
click the iCloud Drive folder inthe sidebar. To see only the documerts that youre shari rg and that are shared with youy, clids the Shared folder. To d-ange
whats showninthe sidezar, choose Finder » Settings.

Get organized.

Your Mac has folders already created for common types of cotert—Documents, Pictures, Agdlications, Music, ard more, As you create documerts, install
apps, and do other woll,, you can create new folders to stay organized. To create anew fol der, chpose File = New Fdder See Organize fies in foders
inte macOS User Guide.

Sync devices,
VWhen you conngct adevice like an iProne or iPad., it asoears inthe Finder siceizar. Clios the device's name 1o 5ee opliors 1o back s, upd ate, sync, ad
restore your Oevice

Gdlery View.

With Gallery View, you can see a large preview of your selected file, so you can visLally i dentify your images, video clips, and other documents. The
Preview pane on the right shows information to Felp you identify the file you wart. Use the scrubber bar at the bottom to guicky locate what you're looking
for. To close or open the Preview panes press Shift-Command-P. To showy thre Preview pane optiors inthe Finder, choose View = Show Preview. To
customize what's shown, croose view > Show Preview Options, then select the octions for your file tyize.

Tip:
To show filerames in Gallery View, press Commard-J and select “Show filename”
Gallery \u’iE:\.\-E Preview Pane
M= Cottos Prasantation .
e ) oo

Intmation

0ap<aBa

o

& Wis -— v

e rEEmr =R

‘Serubber bar Combine POFs, trim audic and '
video files, and automate tasks

Quick Actions.
In Gallery Viewy, click the More button )
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atthe bottom right of the Firder windcw for shortcuts 1o manage and edit fies directly in te Finder. You can rotald animage, anngtate or orop an imagein
Markup, comiingimages and PDFs into a single file, timaud o and video files, run shortcuts created with the Srortauts aon, and create custom actions
through Automator workflows (for example, watenmarkirg a flel. Sea Performguick actiors inthe Finde on Mac

inthe macOS User Guide.

Quick Look.

Select a file and press tre Space bar to open Quids Look. Use the buttons at the top ofthe Qui ck Look window to sign PDFs; trinn audio and video files;
and mark up, rotate, and crop images without opering a searate ags. To leam more azout Quick Look ard mantksus features, see View ard edit fies with
Quids Look on Mac

and Mark up files onWlac

inthe macOSs User Guide.

Tip:
Youl can add atternative image descriptions that can ke read by VoiceOver using Markup in Preview or Quick Look.

Get there faster.

The: Go menu in the menu Zar is a guick way to get to fol ders and locatiors. Instead of usi rg several clidks to navigale to tre Utllities Tolder, dioose Go =
Utiliies. You can also choose Co = Bnclosing Folder to retum fotha op level of nested folders. If you krow the path to a spedfic foder, choose Go = Goto
Folder, then tyze the path. See Go directly to a spedfic foder

inthe macOS User Guide.

Use the Finder with the Touch Bar on your 13-inch MacBook Pro
Use the Touch Bar, at the: top of your keyboard, to perform Firder taskss and more

Use the Touch Bar.
Tap buttors o set view options and guickly look at, share, or tag an item.

BT T O T T
Tapi=

1o see buttons for viewirg and sort ng options. For irstarce, 1ap 83

10 WiEw items iN Fnder as icons.

Tap (O
to see shan ng options:

Tap ¢
1o ses tags you can agply:

To learn more, see Use the Touch Bar on MacBook Pro

The Dack on your Mac
The: Dock, at the bottom of the soreen, is a corverient dace to keep tre apss ard documents you Lse frequently.

Go to the Finder, Open System Settings. |

(000 Ne L | Skl e

Apps in yvour Dock! Recently opened apps

Files, folders, and Trash
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Open anapp or fle.

Clids an app iconin the Dock, or dick the Laundhpad

icon &

inthe Dock to 568 al the apos on your Mac, then click the a0 you wart. You can aso search for an app usirg Spotlight Q

fin the top-right comer of the menu bar), then open the 82 drectly from your Spotlight Search results, Recenty opened aops aopear in 1he certer secton
of the Dock.

K|

Indicates an open app

Close an app.
When you dick te red dot in the top- eft cormer of an open window, the window closss bLt the app stays open. Open aops have a black d otbeneath them

imthe Dock. To dose an aps, Cortrol-didk the app iconin the Dodks and click Quit

Add an itemn to the Dock.
Drag teitemn and drop it where you want it. Place aggs inte left section of the Dock, and files or folders in the right section.

Remove anitern from the Doclk,
Drag it out of the Dock, The item st removed from yoLr MacBook Pro—just from the Dods.

See everyihing that's open on your Mac.

Press the Mission Control key 20

on your keyboard or swipe with three fingers on your trackpad to ozen Mission Cortrol. View your open wirdows, deskiop spaces, full-screen apps, and
more, and Switch Sasily betwesn hem. You can aise add the Mission Control icon B3

o ie Dock. Sae the Apole Supoort artide Use Miss on Control on your Mac

See all open windows in an app.
Force click anapp in the Dock toview all the apid's ooen wirdows. To Force click, dick then press degger.

Tip:
Clige Deskion & DoCk in System Setings
10 dhange the appearance and Betavior of the Dock, Make e Dock larger or smaler, moveitto theleft orright 5 de of the screen, set itio hide when
you're not Lsing it, and more.

Ledarn more,
See Use thee Dock on Mac
inthe macOS User Guide.

Mofification Center on your Mac
Notification Center kegps al of your important irformation, reminders, ard widgsts in ore corvenient idace. Get details about calendar evenls, stooks,
weat e, and more—and catch up on Notificatiors you migh-t have missed (emals, messagas, remirdars, ard more).

Open MNotification Center.
Clioe the: date or time at the top rig-tof the scresn, or swipe | eft ffomthe nght edge of ta trackpad with two fingars. Scroll down 1o 588 more.
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Click to open

Notification Center.

- F Q P TueOct18 ¢

TUESDAY Cupertino

18 Z88

Partfolio work session
10:00-10:304AM

I Pick up lunch ?
1-20M Sunn},lI
11 2 more events H:B9® L:59°

Cupertino Tokyo

Edit Widgets

Focus on what yolre doing.

When you're working, having dinner, or just dort war-t to e d sturzed, Focus can automatica by filter your notificatiors so you see only the ones you
specify. Focus can pause dl notifications or dlow only certain ones to aspear, and it can tell contacts that your nofifications are silenced usirg astatus in
Messages, To set up Focus, open System Setlings

8,

themclick Focus in the sidelar. To tum Focus onor off, dick 8

imthe menu Bar, then didt the Foous section and choose a Focus.

Youl can customize: a Focus 1o fit whatyou're currertly doing. ad all ovr nofifications fromn certain joeople or gops. for phore calls or upcoming evenls, and
more. Yol Can alsoshare your FOCUS acroSs devices and use Foous fiters to hide distracting cortertin apos like Caendar ard Messages

Intera ct with your notificationss.
Redy to an email, listen o the | atest podoast, oF view details about calendar events. Click the arow inthe top-ric-t correr of anoiification to view options,
fake action, or get more information.

Bet your notification settings.
Open Systemn Settings
, theen clidk Motifications to select which notifications you see. Notifications are sorted by most recert.
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Custormize your wicigets.
Glids Edit Widggts (at the bottom of your notifications) to acd. removes, or rearange wicgets. You can also add Hrd-party widgets from the Aop Store.

Ledarn more.
See Use Notification Genter on Mac
iNnthe macOS User Guide.

Control Center on your Mac
Cortrol Center groups all ycur meru bar extras into a single place, givirg you instart access o the cortrols you use the most—like Bluetcoth, AirDrop. Mic

Mode, Soreen Mirroring, Foous, and brightness and velume cortrols—rig-t from the menu bar. Click &
inthe ysperright cormer of the screen to open Control Certer.

Clici for more options,

Clids alsutton to see more options. For example, click the Wi-F button &

10 see your preferred networks, ofrer networks, or to open Wi-Fi Setlircs. To retum to the main Cortrol Center view, click @
agan.

- T Q 8§ TueOcti8 29:41AM

[ Vi

Wi-Fi i
I L Focus ~— Click a button to
BlGstsoth see mare controls.
Cn
: 0 '

fn:’,-,?l,—u,P Ol Stage Screan
Sdichie Managar Mirresing

Dieplay

|
Sound
@ —+—Click to see

AirPlay options.

. ..
¥

Manage vour desktop.
Use Stage Manager 10 0rganize your aios and wirdowsin a Srgle visw and guickly switch betwesn them. You can alse greus aoes togethar tocreate
workspacesided for yolr workflow. See Window management on your Mac

Monitor yvour mic.

Thes recording indicator Shows when your compLters micorophone is in Lseor if it was used récent y. This light increases SecLrity and privacy on your Mac
by leting you know iT an apz has access o the micophone.

Pin your Control Center favorites.

Drag a favorite item from Control Center 1o the menu bar 1o pinitthers, S0 you can gasiy acoess it with a single dick. To crange whatagpears in the menu
bar, open Coriral Center setlings, ther use the dropdown menu next To each module To select "Showin Menu Bar™ You see a preview of where the cortrol
will appea in the meru lar. Some iterms can't be added 1o or removed from Cortrol Genter o the menu kcar.

Tip:
To guickly remove an itemn from the menu oar, press and hold the Command key and drag tre item ot of the menu bar.

MacBook Pro Essentizls 26



LR | Control Centear

& wie Show In Menu Bar &
= EJ siueiooth Don't Show in Menu Bar 2
3 suetoath @ Airbrio Dan't Show in Meny Bar
() matwork
& ven [§ rocus Shom When Active &
£ it BB simgs atanagar Dty Shurias dn Ay Sar 8

Sound

& Scraan Mirroring Shaw Whan Active 3
(8 Focus
8 screan Tima E3 oispiay Show When Active
(12) Garerat & sound Show When Active §
G AppEEance

L) Haw Pisying Shaw When Active §
Acasatilily =
B conval cener

1B s & soariignt T e e

0 rovacy & Securiy
[ Accessibisty Stortcuts
-

Choose additional madules
to add to Control Center.

Learn more,

See Use Cortrol Center onMac

inthe macOS User Guide. Also see Use AirDrop on your Mac
and Use ArPlay on your Mac

System Settings on your Mac
Systemn Settings is tre ¢ ace where yold persondize yoLr MAacBook Pro Settings. For exampie, Lse Lock Scregn settings i change when your Mac goes to
deep. Or use Wallsager settings to add a desktop background.

Custornize your MacBook Pro.

Clids the System Settings icon @

inthe Dock, or choose Aope menu @

= System Settings, then click the setting in thes sidebar you wart 1o adjust. To see acditioral settirgs, you may need lo scroll down. To learn more, see
Customizes your Mac with System Settings

inthe macOS User Guide.
Choose the color
scheme for your Mac.
LN Appaarance
g
Appearanca
({(® romiy
i Azcent colar coeo0O0O R
&3 stustoath
B s Highight cojor B Acesat Celor &
VPN Sidebar icon size Mediim &
3 Notificatians Akow wallpapar tinting in windaws
&l soundt
9 Fors Show scrol bars..
X 0 Atomaticatly bases on mouse or trackpad
B serean Time Wi scralling
LU

&) Gorarat

© et o o v
Accassibility Jump to the spot that's clicked
L:’ Cantrol Cantar

3 5kia sqatiane

[ Privacy & Sacurity

Click an item in the sidebar
1o adjust seffings.
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Update macOSs.
In System Settings, click Gereral, then click Software Usdate fo see if your Macis runrirg tre latest version of macOS software. You can specify options
for adtomatic software usdates.

Spotlight on your Mac

Seotlight @

i an sasy way tofind arything on your MacBaook Pro, S.ch asimages, documerts, contacts, calsndar svents, a~d emal messages. You can also use
Seollight 1o open apes or perform guick actiors, like creafrg atimer.

Search for anything.

Clide O,

atthe top rigt-t of the soreen then start tyioing. On the 14-nch and 16+ rch MacBook Pro, you can also press he Spollight key §+4) on your keylzoard, With
Live Text, Spotlightcan search for text in images. Not dl larguages are available.

Tip:
Press Commard-Space bar 1o show or hide the Spotlic-t search fiesld.

Start typing, and results
appear quickly.

Q horse photos

@ horse photos

@ horss photoshoot
@ funny horse photos
@ horsa racing photos

& horses photography

Open an app.
Erter the app rame in Spotlights then press Returm.

Perform guick actions.
Youl can gui ckdy do certain tasks with Spotlighty ike rurning a shortcut, starting a Focus, or setting an alarm. Open Spotlighty then search for the action you
wart to perform, For instance, type Clock, then choose Create Timer to set a timer directly from Spotlights
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& temer clock
@ timer
@ tmer clock for 16 seconds

&t clock seconds

Timer Pro

Timar On Demend

pa G

| Wiridwide Timer

=

& Search the Web

W& Searchin Finder

Convert currencies and measurements
Erter acurrency—like §, €, or ¥—and an amount, then press Retum toget alist of corverted valles Or spedfy a utitof measure for measuemert
COrversions.

Use Siri Suggestions.
Sin Suggestions offer info from VWikipedia articies, wes search results, Mews, S00Ns, weather, stocks, Moves, ard other sources wien you 58arc with
Spotlight.

if youwart Spotlight to search only for items on your MacBook Pro, open System Settings
. Clide Sin & Spotligrt, then dick to deselect Sin Sucgestionsin treslist of Search ResuUts. You canalso make other changes to thelist of categories

Spofligrt seaches.

Learn more.
See Search with Spotlig-t on Mac
inthe macOS User Guide.

Siri on your Mac

You can activate Sifi with your voice on your MacBook Pro ard use Sin for many tasks. For examid & you can sthedule meestings, changs settings, get
answers, send messages, places cdls, and add items o your calencar. Use Siri to give you directions (*How do I cet home from herg™

), provide information fHow high is Mourt Whithey 7

I perform Dasic tasks ("Create a new grocery list”

J: and much more,

If youenadle the "Listen for Hey Sid™ option in Sri setings, Sid is avalla?le whenever you say "Hey Sd” and i mmediately spea< your reguest.

Maote
To use Siri, your Mac must be comnected 1o the irtermet. Siri may rotloe avalasle indl larguages orinall areas, and features may vary by area

Enable and activate Siri.

Open System Settings

, Click Sifi & Spotiigrt, and set options. If you erabled Sir durirg setup, onthe 13Hnch MacBook Pro, either 135 the Siri cutton ©

inthe Cortrd Strip on the Touch Bar, or press ard Fd d Command-Sgace Bar to open Sid. Ch the 14-inch or 16-inch MadBook Prg, press ard hold he
Dictatior/Siri (F5) key ©

o open Siri, Or click Sid & Spotlight in Systemn Setlirgs, tren select Ask Siri, You can set other Sin settings, such as the language and voice to use.
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L L Siri & Spotiight

B s «
Keytard sharicut Hold Command Space &
Languags Engiish (Unitad States) &
5iri Volce Hean (Velce 4 Solect
Siri Higtary Dislato Sl & Dictatian History

(] Sirl Suggestians & Privacy. Sirl Respansed s

(9 rocue

- Spatiight
E3 screen Time :
3] Geneeal

Search results
@ sovearunce i

=

Acceasiti & Applications

5 Bookmerks & History

ity

e Cakculator
0 Privacy & Secinty £ Eontaes
& Conversion
Tip:

You can add the Siri icor to the menu ar by selecting that option in Cortrd Center settings. Then dick tre Sir icon ©
o Lse Sin.

Hey Siri.
On your MacBook Pro, you can simply say “Hey Sin™ 1o get responses to your requests, To enald e this festure in Sini settings of System Settings, click
L isten for “Hey Siri',” then speak several Sii commands when prompted.

For convenience, “Hey Sin” doesnt respond when ire id to your MacBook Prois d osed. If the lid is closed and
connected to an extzrna display, you can still activate Siri from treicon in e menu bar.

Tip:
To |earn albout more ways you can use Sin, ask “What can youdo?”
atary tme, or see the: Asple Support article What canl ask Sin?

Play some music,
Just say “Play 50me music
" and Siri does the rest. You can even tell Sin, “Play the top song from March 1981

1

Drag and cdrop.
Drag and drop images and |ocations fom the Sin window into an emall, text message, o documert. You can dso copy and paste text

Change the voice.
Clids Siri & Siootlightin System Settings. then choose an option from the Sii Voice meru.

Throughout this gude, you'll find suggestions for things you can Lse S for—they look like this:
Ask Siri.
Say something like:

[ ]
“SHoWw ME My remndes.”

“VWhat time isitin Paris?”
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Learn more.
See the Us= S onMac
inthe macOS User Guide.

Window management on your Mac

lt's easy to find yourself with a dozen open apps and one or more windows Tor each app open on your desktop. Ludkily, trere are some effidert waysto
see and navigate the windows you have open. When you wart to focus, you can exsa-d one age o fill the whole screen or choose two aops to shae the
screen. Automatically organi ze your a30s and windows with Stage Marager 1o keep your deskioe clutter-free and guickly move between tasks, Yhen yvou
reed to find awirdow that’s buried, use Mission ool fo show all your open wirdows ina sind e layer. You can use mullicle desktop spaces to spread
out your work on differert desktops and easily move between them.

Click to see
(window options.

“Light Physics
Study Guide

el

Use the whole screen

Use full-screen view when you wart your app tofil the whole screen Mary apps on your Mac such as Keyrete, Numbers, and Fages, support full-screen
W ew. IN full Screen, the menu bar is iidden urtil yold move 18 poirter over the 1op of the screen, oF you can chiooss 1o dways show the menu ibar. To erter
or leave ful-scresn view, move the pointer over the green Ruttoninthe top-left correr of 17e windowy, then dioose Erter FUll Screen from thes menu that

appears. See Use apps in full screen
inthe macOS User Guide.

Split the: screen

Use Split View to work in two app windnws side by side Like full screer, the two wind ows fil the screer. Move tre painter to the green bbutton in tre top-
lesft corner of a windcw you wart 1o use, then croose Tile VWindow to Left of Screen or Tile VWindow to Right of Screen from the meru that appears. dick
another window and it aLtomatically fils the othar haf of the screen Whenthe poirte is over the gresn tutton, the meru that gosears has options to
switch apos, take the two windows to full scregn, and more. Ses Use agssin Split View

inthe macOS User Guide.

B o i - niE mendw

CLOSER
TOME

A child’s journey to self-discovery
s always a winding road.

T s o er
mtant, A proat i Imtin L.
el e rocopri e e s L presting 1f

Stage Managjer.
Automatically organze your apssand windows 50 your desktos stays clutter-fress What you wart 1o foous on is frortand center with your oher windows

MacBook Pro Essentizls k1l



arranged onthe side and accessible with a sincle click. Open Cortrol Center and click Stace Manager. See Organize your Mac deskiop with Stage
IMarager
inthe macOS User Guide.

Mission Cortrol.

Qui dely move your open windows into asingle layer, then dick a window to return to regular view withthat window in front and active. fyoutavs
additional desktops fspaces) or have azps in Split View, they aspear ina row alorg the top of the screen. To enter or lsave Missi on Control, press 20
on the top row of your keyboard, or press Cortrol 4 Arfow. You can also add the Mission Control icon EQ

to the Dock. See Ses open windows and spacesin Mission Cortrol

inthe macOS User Guide,

Whien one desktop st enouch.

Organize your app windows into muliple desktop spaces, then switch between them as you work. To create a space, eter Mission Cortrol and click the
Add Desktop button +.

Use keyboard shortouts and Mission Gontrol tomove between your soaces. You candrag windows from cne space o anoher and add or delete spaces
a5 yol work. See Work in multiple spaces

inthe macOS User Guide.

That horizontal traffic light.

Thes red, vallow, and greenbutions inthe top-1eft corner of every window arertt just for stow Click the red button 1o close an 8510 window. For some aigos,
this guits the ao and closes all open windows for the ajgs. For others, it d oses the currert wirdow DLt leavess the app open. The yellow Bution closes the
window temporadly and puts it inthe nght side of the Docke ¥YWhen you want to reopen it, click it in tre Dock to expard it And e green button is a quick
way 10 change your windows 1o full scréen and Split View, and more.

Display settings for your Mac

Match the light in your surroundings.
Your MacBook Prohas Trus Tong techrology. Trug Tong automaticaly adapts the ool or of the display to match e light in your snvirorment for a more
natural wiewing exserience. Tum True Tore on o off in the Disslays settirgs in System Setirgs

Used dynamicdeskiop.

When you Lse: a Gynamic deskiop picture, the deskiop picture altomaticaly changes o matdh the times of day in your location. Click Wallpaper in System
Settings, ther choose a picture for Dynamic Desktop. To have your screen changs based on your time zore, snabble Location Services. If Location Services
s turned off, the picture changes based on the time zone speafied in Date & Time settings

Stay focused with Darkk Mode.

You can use a dark color scheme for the desktop, menu bar, Dode, and al the buitinmacOS apps. Your contert stands ot frentand center while
datkened cortrols ard windows recede into the backgroLrd. See white text on a black padsground in apps such as Mail, Cortacts, Cderdar, and
Messages, 50 TS 2asier on yoll 8yes when yoldre wolki Mg in darke enyironmerts,

MO =EUDEEPER- "7 EESD B
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Dark Mode is finehy tuned for professiorals who edit ptotos and images—cd ors and fire details jpop against tre dark app backgrourcs. But t'salso great
for anyone who jLst wants to focus on their contert.

Night Shift.

Switch yolr Mac to warmer colors at night or inlow-igh-t cond tions 1o reduce your exposure 1o bright blue light Biug light can make it harder 1o fall aslegs,
S0 warmer screen colors may hedp you get a better nig-tsrest. You can schedule Nig-t Skift toturn on ard off actomatically at sppedfic imes, or set it to
come onfrom surset to surise. h Systermn Settirgs, dick Disdays, dick the Night Shift button at the bottom, then set your options. Drag the slider to
adjust the col or femiperature.

Connect a display.
Yold can cornect an externa display, a projector, or anHDTV to your Mac. Ses Use an exterral display wit your MacBook Pro

Learn more,
See the Apple Support arfic e Using a Retina display

Transfer your data to your new MacBook Pro

It's gasy o copy your files and settings wirelessly frem arot-er Mac or PC to your MacBook Pro. You can transfer information to your MacBook Pro from
an existing computer or from a Time Maching backus on a USB storage device.

Yol might need to upgrade the macOS version on your clder computer before you can transfer the irformation on it—Migration Assisiart requires macOS
10.7 or later, but it's best fo update your older computer fo the latest version poss He If you're not sure which MacBook Pro you have or wart to fird
irformation about other models, ses the Aonle Support article Idert fy your iMacBook Pro model

Tip:
For zest results, make sure your new WMacBook Froisrurrrg the latest version of macOS. Open Systemn Settings
, then click Gereral » Software Update to chede for updates.

Move from a PC to a Mac.
If you're new to Mac and wanrt 1o transfer from a VWincows computer, see Transfer irfo from a PC o Mac
inthe macOS User Guide and the Apcle Supsort artid e Wiove your data from a Wirdows PG to your Mac

Transterwirelessly.

f you did™t transfer wour data when you first Set ud your MACBDOL Pro, you Can LS8 Migration AsSistart at ary ime, Opena Fndser wirdow, 8o 1o

Aopli cations, open the Ltilities Tolder, then double-click Migration Assistat and follow the onscreen instrictions. Make sUre both compLters are corrected
1o the same network, and keep the computers near each otter throughout te migration process.

N
=

Tip:
To transfer the information wire essly fom your existing computer 1o your WacBook Pro, make sure both compLters are connected 1o the same networc.
Keep both computers near each other throughiout tre migration process.
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I you Lsed Time Machine 1o back up your files fromanother WMac to a storage device (such as an extema disk), you can copy the files from the device to
your MacBook Pro. See Back upo and restore youw Mac

Copyfiles from a storage device.
Connect the: storage device to your MacBook. Pro using an aoicropriate adapter if necessary (see Adapters for your MacBook Pro
1 Thendrag files from the: storage device to your MacBook Pro.

Restore your content.
To learn howy 1o restore your Mac from a Time Macking or otrer iackys, see the Apple Supicort artid e Restore your Mac from a badeLp

Learn more.
Sese Transfer your i rformation 1o Mac from another compute o device
inthe macOS User Guide and the Apple Supgsort artide Move your contertto anew Mac

Back up and restore your Mac

To keep your files safe, it’simportant to back up your WiacBook Pro recl.lany. The easiest way 1o back Lp § 1o use Tme Machire —which is built into your
Mac—1o lzack Lp your asps, accourts, settings, music, photos, movies, ard documents. (T e WMachi re does 't iback up the macOS operatling system).
Use Time Machine to back up to an exterral storage dewvice comected to your MacBook Pro, o to a s.pported network volume. For a list of devices
supported by Time Maching 562 1he Aoole Support artid e Backup disks you can Lee with Tme Macking

Set up Time Machine.
Make sure your MacBook Pro is on the same VWi-F network as your extérna storage device, o connact the external storage devics to your MacBook Pro.
Open System Settings, click General = Time Machine, tren dick Add Backup Disk. Select the drive you want to use for badcus, ard you're dl set

BAck up withiCloud.
Files iniCloud Drive and photos in iCloud Photos are actonatically stored in iClbud and don't need 1o e part of your Time Machire badeup. Howevysr, if
you'd like to zack them p, do the following:

L]
iCloud Drive;
Open System Settings, clidk Apple 1D, then dick i oud and desed ect Ogtimize Mac Storage. The cortents of your i old Drive will be stored on your
Mac and induded inyour backup.

iCloud Photas:
Open Photos, choose Pholos > Settings, then click iCloud ard select "Dowr oad Criginds to this Mac.” Full-resolution versiors of your entire fhoto
lorary will lse stored on your Mac and included in your ackup.

Restore your files.

You can use Time Machine 1o restore all your files at orce Click the Time Machineicon in the meru kar, then choose “"Browse Tinme MacH re backups™ (if
the Time Machine iconismt in #e meru bar, choose Apple Menu @

> System Settings: then click Control Certer inthe sidezar Click the sop-up menu next 1o Times Maching onthe right, then choose anopton) Sdect ong
or more itemns that you want to restore findividud folders or your értire disk), then clidk Restore.

If youuse Time Machire fo back up your Mac, you can recover your files if the operating system or startup disk is damaged, Te dothis, you must first
reinstall macOS on your Mac before you can restore wour fies Lsing your Time Machire backup. Read onfor more irformation
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- Browsable backups

July 2022

The selected backup
you're browsing is red.

Remnstall macOS.

Your operating system files are kept separate from yolr parsonal fies in a sealed system diske However, s3ome actions, ke erasing or inadvertent y
damaging a disk, reguire that you restore your MacBook Fro. You can reinstd| macOS ard then wse Time Machine fo restore your personal fles from your
backuo. Wth macOS Big Sur and later, there are several ways 1o restore your Mac. You may 3 required to install a rewer version of macOS than what
wour comuter originally came with, or what you were Lsing before the digk was damaged. Tolean more abolt these options, see Recover all your files
from a Time Maching backup

inthe macOS User Guide and the Apple Support arid e How toreirstd | macO3

Important
Advanced users may wart to create: a ibootableinstalle 1o reinstall macOS in tre future, This can be useful if you want to use a specifc version of macOs,
See the Apple Support artid e Fow to create a bootable insta ler for macOS

Restore factory settings.
Youl can restore yolur Mac to its ongind state by &rasing your Mag, then using macOS Recovery toreinstal macCS. SagFrasae your Mac
inthe macOS User Guide.

Learn more,

See Back up your files with Time Machine

and Time: Machine troubleshooting onMac

inthe macOS User Guide. Also see the Apple Support article What to do before you sell, give away, or radein your IMac

Accesshility on your Mac

Your Mac, i08 devices, and iFad0S deviCes ind Lde powerful 100 S 10 Make ApE € Broduct features ava@ible ard easy toUse by all. There are four main
accessizility focus areas for your Mac. Click a link tolean more 3oLt the features Tor each arex

L]
vision
Hearing

Mability

Cognitive
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For comprehensive detals about Accessiklity support in Apple products, oo to Accessibility

Accessibility settings.
INSysten Settings
, Accessibil ity Settings ae orgarized around topics of vision, hearing, and motor, makirg it smg er to find what you're lookirg for.

Live Captions (Beta).
Add red-time captions for conversatiors, audio, and video. Notavailable in all languages, courtries, or regions. See Use Live Capgtions
inthe macOS User Guide.

Do it all with Voice Control.
You can cortrol your Mac with just your voice. Al aLd o processing for Voice Control happers on your Mac, so your persona da@a s ket private, See
Cortrd your Mac and aprs using Voice Control

Accurake dictation

If you can’t type by hand, accurate dictation is essertial for conmuni cation, Voice Cortrol brings the | atest advances inmaching leamirg for speech-to-text
trarscrgptiom

Dictate custom spelings letter by letter. You can also add oustom words to Felp Voice Control recogrize the worcs you commonty use. Chocse System

Settings = Accessibility, sdect Voice Control, dlick Vocasulary, thenadd 1e words you want. To oustemize commands in the Veice Cortrol setlircspage,
click Commands, then select to keep defaut commands or add new ones

Notes
Thes dictation accuracy improvermerits are for these languages: Brglish (US UK, Ind a, Australa)y Mandarin Chinese (China mairlard), Cartorese fHong
Kong), Jasanese (Jazanl, Spanish (Mexico, Latin America, Spair), Frerch (Francel, and German (Germany).

Rich text editing.

Rich text editing commands in Voice Control let you guickly make corrections and move onto exaressing your next idea You can replace one phrase wth
another, quickdy position the: poirter 1o make edits, ard select text with pred s on. Try sayi ng *Replace *Jan will e there soon’ with *John just arived”
VWheEn you CorreCt words, word and 8mMoji SUQSEST Ors helD You gUICKk]Y S&18ct what you want.

Comprehensive navigation.

Use voice commands to open and i reract with apps To didk an itam, just say its accassiality [akel rame,. You can also say “show numiers” 1o 568
rumizer labals appear next to all clickakle itemns, and then say a number o clios. f you nésd 1o touchapart of the soreen without a control, you can say
“show grid” 1o superimipose a grid on your screen and do things like click, zoom, dag, and maore.

Hover and zonom.
Use Hower Text 1o display high-resolLtion text for screen items urder your pointer. Press Command while hovering over text with te pointer and a window
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with Zoomed text apsears on your screen.
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Zoom Display lets you keep one monitor zo0med in tightly and another at its stardard resd Ltion. View the same scresn up dose and at adistance
s multareously.
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Make an easy-to-see custom ponter.

Customize the outling and fill color of e mouse poirter 5o its asier 1o recogniZe when it moves or charcssto aninsartion point cresshair, hand, of oher
shape.

IMproved keybOdrd ACCess,
An exgpanded set of keyicoard shortouts allows you to cortrol everything on your Mac with a keylboard —no mouse ortradsrad reguired.

Use VoiceOver, the built-in Sscreen reader.

voiceOver describasaloud what aspears on the screen and spaaks g text in doouments, welspagss, and windows. Using VoiceOver, you control your
Mac with the keyboard or tradkisad gestures, or connect a refreshalde braille display to use with voiceOver. To cLstomize voiceOver, Lse VoiceOver Utility.
See VoiceOver User Guide

O ask Sini.
Say something likes
L]

HTurn VoiceCwer on.”
“Turn VoiceOver off.”

Use Siri for VoiceOver.

If you prefer the: matural voices of Siri, you can choose touse Siri for VoiceOver or Sipeechy Simyd ified keysoard navigation reqguires less drilirg into Lrigue
foous grolos—making it even easier to navigate with VoiceOver. Yol canalso store custom punctLation mariks in iCloud, a~d choose from Irtermational
Braille taoles. And if yolfre A developer, VoiceQver row reads d oud ling Nnumicers, bredk points, warnings, and ervors in ihe Xcode text edior.
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VoiceOver image descriptions.
Using Markupin Preview or Quick Look, you can add altemative image descript ors that can be read by VoiceQver, Image cescripli ors persist even when
shared and can ke read |y a range of supiorted aoes on Fhore, iIPad, and Mac.

VoiceOver PDF signature descriftions.
Add customdescriptions to your PDF signatures S0 you can idernt fy them guickly and choose e right ore.

Color enhancements.
If you have a color vision defidency, you can adjust your Mac display colors using cal or filler options. It's easy toturn this settirg on or off 1o guickly
differertiate a color Lsing the Accessibility Options panel, whidh you can access by tripleoressing Touch ID.

Background sournds.
Mask unwated enyvironmerta noise and minimiZe d stract ons with calming sourds like ocean o rain.

Custornize your Mermoji.
Add cochlear impiants, oxygen tubes, and a soft helmet for headwear 1o your Memoji. See Messages
10 lsam azout creating your Memoji.

Ledrn more.

See Get started with accessibility features on Mac
imthe macOS User Guide.

New features on your MacBook Pro

macOS Verturairtroduces new features and improvements to b p you get tre most oLt of your Mac.

Take your productivity and creativity to the next level with new ways to get more dore:

L]
Mait:
Ursend an email you just sent, schedule emalls 1o be sent whenever you like, ard get reminders to followr up or come bads to an emal latzr. When you
searchin Mail, you now receive suggestions for recenty skared cortant, like doouments ard links, Search aso provd 85 mMore accurate resuUlts it’s
awae of when yol make tyioos and it searches for synoryms for your search ters. See Mail

Fregform.
Anrew app that you can use: to b nstorm by yourself or with othesrs. Create aboard and add text, media, files, ard more. Access your bcards onal
your devices and see changes in real time. Avallable startihg on mac0S5 13.1 ard i05 16.2. See Freeform
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Stage Marager:
Automatically orcanize your apps and windows so your ceskioe stays dutter-free What you wart to focus on is frort ard center, with your other
windowys arranged on the side and accessid e with a single click. Ses Window management on your Mac

Spaottight:
With Spotlight, you can jperform Quick Actiors, ke sstirga timer. Ard enharced image search in Spotlight lets you seach for images in Photos,
Messages, and more, or use Live Text to search red textinimages See Spotiight on your Mac

Safan:
The word's fastest browser with a focus on protecting your rivacy.™ Safari row has passkeys, 3N evsn Moe Secure way 10 5ign-ir, keeping you safe
from phishingand data |eaks. See Safari

Focus:

More options to customize a Focus to it what youre cunently doirg, and allowy rotifications from certain people or apps, for phore calls or upcoming
everts, and more. Share your Focus across devices and use Foous filters o Hde distractirg comtertin agos like Cdendar, Messaces, Safar, and Mail.
See Notification Certer on your Mac

Share experiences and collasorate more seamlesslyin your favorite apgps:

Mgessages:”

Messages can now Be Lsed 1o serd an invitation to coll @sorate on projectsinother apps like Keynotes, Numiers, Pages, Notes a~d more. Messages
also now includes other mew features, including the capability fo unserd a recertly sent message for up to 2 minutes after sending it or edit a recertly
sert messages for up to five times within 15 minutes after sendrg it See Messages

iCloud Shared Photo Library:
Add phot0s and wideos toa library that you can share with up 1o five other people. Everyons’s edits, commerts, and new content shows up for

evEryone glss, ad you £an LSS Smart Suggestions 1o aLiomaticaly add certain photos or vdeo from your personal liorary, like those featurirg specfic
people or from a certan datz. See Photos

Activity Strearm.

With activity Stream, you can keep frack of every change whi e cd lalzorating on a Mumbers, Keynote,or Pages documert. A detalled list in the sidebar
shows all edits, commerts, and other file management dhanges. See Pages

» Keynote

» 8hd Mumisers

Use your Mac and all your devices Together in new ways:

Caontinuity Camera:
Nowy when you're on avideo call, you can use your iPhone as your weltcam, ard it works wirelesdy. You canalso use Desk View to share what's on
your desk infront of wou, while providing a view of your face. Avalabsle oniPhone 11 or later Sees Cortinuity Camera on your Mac

FaceTime:
With FaceTime, you can now handoff a call betweendevices. If you're on the g ard start aFaceTime call on your iPHong, you can tramsfar it to your
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MAacBook Fro when wou reach home O you can start that FaceTime call at yolr desk ard take it with you whenyou leave the Fouse. See FaceTime

Home:

The Home app has an all new design that makes it easierto navigate, organize, vieww, and control all your accessories. View your entire home ata
glance, Lse categoriesto quickly access all of your relevant accessories by room, and navigate accessories, categories, ard rooms with an uodated
sidetar and new tile design. See Home:

And somuch more. macOS Vertura also provides these new features:

Noles:
You can now use your Mac login password 1o lock anote. You can also organize your notes more eadly wih Smart Folders that can automatically find
notes by Tags, Mentions, Quick Notes, Date Created, ard more. SeeNotes

Ferminders:

The Teday and Scheduled Lists have been improved with time- and date-based grousing, making it easier 1o view and add remirders. Yod can aso
save alist as a template to use later, whether it's a padting list for a trig, a project checklist, or somethirgelse. See Reminders

Clock:

The Clodk app on iPad and iPhone is now aval able on your Mac. In addition to settirg world d ocks, timers, and alarms wittinthe apo, you canalso
create customized Clock storcuts that you can access from the menu bar or Frder, or by asking Sin. See Clock

inthe macOS User Guide.

Systern Settings:
Arew look for Systemn Preferences. See System Settings onyour Mac

Accessibility:

See Live Captions Beta) when walching video, listening toaudio durirg conversations, or on FaceTime calls. Play badeground sounds to help you
focuLs. S8Iect New |ANGUAGES aNd vOiEEs 10 USE for VoiCEOYEr and SPCkeEN COrtaTt. Yol Can USE Voi CEOVEN 10 ChiEtk for COMMmMon {omattirg issues, Uss
voice Control 1o hang Uz FaceTime calls and dictate custom szellings | etter oy lettesr. Link two cortrollers when gaming with buddy cortroller. See
Accessibility onyou Mac

MNews:
In the News app, My Sports lets you follow your favorite teams, | eagues, and athletes; custori ze your feed to see tre |atest stories; watdh highlights;
and get scores, schedul es, and standings for the teams and |eagues youl loves See MNews

Weather:

The Weather app is now available on your Mac, with a design optimized for a larger display, induding immersive animations detaled mags, and
clickaole forecast moduss. See Weather

inthe macOS User Guide.
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Use MacBook Pro with other devices
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Use your MacBook Pro with iCloud and Continuity

With iCioud, you can kesp yolr irfomation up to date on dl your devices and collasorate with friends and famiy. Your MadBock Fro works seamiessly
with your iPhong, iPad, iFod touch, or Appie Watch when you use i G oud and sign in to each of them with the same Apple ID

. You can transfer files, share and edit documesrts, LSe your iPhong camera as a wedscam for your MacBook Pro, hand off tasks betwesn devices, skare
purchases and storage with Family Sharing, and more.

If youdidm't turn oniCloud when you first set up your Mac, open System Setings

, clide "Sign inwith your Apdle IDY inthe sideksar, tren sign in with your Agple 1D

, or create anew Apple 1D if you don't have one. After you are signed in, dickiQoud, thentum iCloud features on or off. To kam more, see Set up iClod
features on Mac

inthe macOS User Guide,

Access yowr content across devices.
With iCloud, you can securely store, edit, and share your documents, photos, and videos across devices to make sure you're always ypo to date, To get
started, see Access your iCloud cortent on your Mac

Use your MacBook Pro with other devices.

Seamiessly move cortent bestween your MacBook Pro and other devices usirg Continuity. Just s onin on each device with your Apple ID

, 8nd whenever your MacBcok Pro and devices are nea each other, they work togetterin converiert ways. You canstart a task —ike a FaceTime call—on
one device and finish it onamother (see Use Hardoff on your Mac

1. Lse your iPhione as a webcam for your WMlacBook Pro (sees Cortinuty Camera on your Mac

J» COpY and pastes between devices (Bee Use Uriversa Clipzoard on your Mac

)y answer cals or send texts from your MacBook Pre {see Phore cdls and text messages on your Mac

) and more,

For alist of system requirements for devices that support CortirLity, see tre Aople Support article System requirements for Contiruity on Mac, iPhore,
iIFad, and AppeWatCh

. To learn more about using Cortinuity with your MacBook Pro, see the &30 & Support article Use Cortinuity 1o connect your Mac, iPnone, iPad, and Agole
Watch

or goto Allyour devices

Aahlay Rico

A

w7

Ashiey Rico |
ashiey_ricot@ichoed.com |

Access your iCloud content on your Mac

iCloud hel ps you kee your most importart information—like your photos, fies, and more—safe, up o date, and avalal?s across dl your devices. It's built
irto every Apple device, and everyone gets 5 GB of starage o start. Furchases you make from the Ao Siore. Apple TV apo. Aople Books, or iTues Store
dorftcount toward your available space, So if you have an iPone, iPad, or iPod touch, just signinon each device with your Apple D

, turman iClouwd, and you have everything you nesd Yold can upgrade i Clouds if you nged morg storage and premium features including iCioud Private
Relay, Hide My Email, Custom Emall Domain, and HomeKit Secure Video support.
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For system requirements about devices that support i Qoud, see the Apd e Support arti cle System requirements for iCloud

Aulomatically store your desktop and Documents tolder in iCloud Drive.

Youl can save files in your Documents folder or onvour desktop, ard they're automat ca iy avalable on iCloud Drive and access He wherever you are. When
warking with iCloud Drives, you haves access to fles on your MacBook. Pro, on your iPhone oriFad in the Files apr, on the web at iCloud.com

, Or on awindows PG in the iGioud for Windows aoiz Whenyou make chances to a fies on a devices or onilioud Drive, you'll 588 your ed t5 wherever you
vew the fle.

To get started, open System Setlings
y clids onyour Aode 1D in tre sideksar, dick (Clold, thentumon iCloud Drive. To leam more, see Sat Lo and wse iCloud Drive on all your devices
intheiCloud User Guide Also see the Apsle Support aricle Add your Deskiop and Documerts files to iQoud Drve

Store and share photos.
Store your iphoto liprary iniCloud and see your photos and videos, as well as the edts you make to themn, onall your devices. To getstarted with iCloud
Photos, open Systemn Settings, clidc on your Aople 1D inthe 5 de bar, click iCloud, then tum on Protos,

Use iCloud Stared Photo Ligrary to share photos and videos withup to fue other people. Everyore can make changes —like adding new contert, making
edits, or addirg commeris—to the shared library. Smart suggestions make it easy to add particular photos fom your collection, sieh as photos featuring a
soecific person or takenon a certaindate. To get started, go to Photos = Setings, clids the Shared Liorary tab, and follow the onscreeninstructiors To
lEam more Apout ICIoud Proios, see Lse iCioud Photos oniCloud.com

inthe iCloud User Guide.

Enjoy youlr purchiases anywhere.

VWhen you're sigred in to your devices with thes same Agsle |0, purchases you've made onthe Az Store, Apple TV app, Apde Books, ad iTunes Store
are avallate at arytime, no metter which compLter or device you used to purchase them. So all your miLsic, movies, books, and more are available
wherever you go.

Locate your MacBook Pro with Find My Mac.

If your MacBook Pro ismissing and you have Find My Mac fumed on, you canuse Find My

1o locate iton amap. lock its screem, and even erase its data remotely. Tofurnon Find iy Mac open System Settings, click your Apde ID in the side bar,
click iQoud, then tum on Find vy IMac., See the Aople Support article If your Macis lost or stolen

Maote
If your MacBook Pro has multticle user accourts, only oNg can have Find My Mac turned o,

Do more wath iCloud+.

iCloud+ is a suiscristion service that gives you dl the storage tiers ard sharing features of i Cloud but with additiond features. Youcan share any size
iCloud+ storage plan through Family Sharing. iCioud+ also ind LdesiQ oud Privats Relay, Homadt Secure vides, ard custom email domaing for your Mail
address on iCloud.com. Here’s what you get with aniCloud+ sulbscription
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Storage”
50 GB, 200 GB, or 2 TBof iCloud storage.

[Clolid Private Relay:
Private Relay is an intemet privacy service that hides your IP address in Safari and [protects your urencrypted traffic, When t'son, you can browse the
web with extra secunity and rivacy.

Hide My Ermail;
Create unique, random email addresses that forward 10 your peErsorad inkax, 50 you can send ard receive email without having 1o share your persoral
email address.

HomeKit Secure Video:
Connect your home security caneras inthe Home app o record your footage and view it from anywhere. t's end-to-end ercrypted, and none of the
video counts against youriCloud storage:

Custorm email dorrains:

Fersoraize your iCioud Mail address with a USiom domain name. You can invite your Tamily menoers 1o uss the same doman withthair iCoud Mail
accounts.

Fafmily Sharing.
Al iCloud+ plans can be shared with up to five famiy memisers, so evaryors canerjoy all these features and induded storage with a single
subscrption.

Learn more.

See the iCioud User Guide
and What is iCloud?

inthe macOS User Guide.

Screen Time on Mac

Screen Time shows how you sipend time onyour MacBook Fro, provides Tools to make it easy to step away during dowrtime, andlets you monilor wiat
WOUr kids are doing on their Apsle devices.

Bee how you use your MacBook Pro.

View reysorts To seeshow much limes youlre spending with apps ard welosites during a sirgle day or across a week, find oLt which agos notify you the most,
aNd 5E8 howy OftEN you IDiCk UD yOLF deviCe e3ch day. OpeN System Settings, Choose Saeen Time in t& sdebar, then dick ADD Usages, Notifications, or
PiCkUps.
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LN Screen Time

Famity Membar & Ashlay Rico T
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(@ content & Privacy

Shara across davices

Set your limits.
Set limits to control how much time you spend with sped fic asps, categaries of apos, and wedsites. In Screen Time, choose Dowrtime, then create a dally
schedule or a custom onefor every day of thes weske

Manage your kiel's screen time.

Parerts can corfigure Screen Time on their Mac —or iProne or iIFad—and everything is set up for their kids on their devces, You can also set age-basad
media ratings for the Music and Bcoks apes. See Set up Screen Time for achild on Wac

o leam more,

Domt miss the important things.
Choose which apps or website you always need access o In Screen Time, choose Always Alowed, thentum on the asps hat you wartto remain
avallable duing downitine,

Ledrn more.

See Marage dowrtime in Screen Time

and Set up contertand privacy reStictions in Screen Time
inthe macOS User Guide.

Use Handoff on your Mac

With Handaff, you can continue on one device where you left off onanother. Start aFaceTime cal onyour iPhore, then ransfer the call to your MadBook
Pro when you getback to your des. Cr work on a presertation on your MadBook Pro, then conlirue om your iPad. View a message on your Apple Walch,
and respond 1o i on your MacBook Pro. Handoff work s with FaceTime, Safar, Mal, Calerdar, Cortacts, Maps, Messages, Notes, Remircers, Keynote,
Numbers, and Pages

Maote-
To use Handoffy you need an iPhone or iPod touch with iOS 8 orlater, or aniFad with iFadOS instal ed. Make sure your MadBook Pro, i0S dewice, or
iFadOS device have Wi-F and Blustooth turmed onard ae signed in withthe same Apple ID

Hand otf actions between devices.
For most activiti es, when your MacBook Pro and other devices are near each otrer, anicon appears in the Dock when that activity can e Fanded off; dick
the i con to hand off between your dev ces.
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Click to continue what you
|were doing on your iPhone.

For FaceTime, noicon appears in the Dock. for hand off. Instead, if you want to hard off acal from your iPhore or iFad to your MacBcok Pro, dok L1
imthe menu bar on your Mac, dick Switch, then dick Jaininthe FaceTime wirdow on your Mac. To hand off a FaceTime call from your MacBook Proto
wour iPhone or iFad, tap R

inthe yzper left of your iPhone or iPad, tap Switch, then tap Switch again.

Turn on Handoff on your MacBook Pro.
Open System Settings
, clide Gereral in the sidebar, click Airdrop & Handoff, then select “*Allow Fandoff betwesn this Mac ard your iCloud devices”

Turn on Handoff on youri0S or iFad0s dewce.
Go to Settings » Geraral » Handoff, tren tap to turn on Handoff, If you dort see the oition, your device doesTt sugport Handoff.

Turn on Handoff on your Apple Watch,
In ihe Appie Watch a5p on iPhong goto Settings = General, then t35 1o turn on Bhades Handoff.

Learn more.

See Pick up where youleft off with Handoff
inthe macOS User Guide.

Use Universal Clipboard on your Mac

Copy Cortent from one devite, And pasts it arot-ar nSanty devics within a sntrt 3erind of tmea The conterts of your Clilss0ard are 58t over Wi-Fi and
made avalable to al Mac, iPhore, iFad, and iPod touch devices that are sigred in withthe same Apple 1D
and have Hardoff, Wi-Fi, and Bluetooth tumed on. See Use Handoff on your Mac

Note.
To use Universal Cligisoard, you need aniPhone or iPod fouch with iOS 10 or |ater, or aniFad with iPadOS instaled.

Use across apps.
You can copy and paste images. text, photos, and video between any apiss that supicort copy and paste on your Mac, iPhone, iPad, and iFod tcuch.
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Copy and paste files.
You can qui ckly move: fles from one: Mac to anotterus rg Universd Clipksoard. Copy a file on your WacBook Pro ard masteitto aRrcer window, Mail
MESSsAge, or ary ass on aneansy app that suspotts copy ard paste. You must e sagned in with the same Asple ID onboth complters.

Ledrn more.
See Copy and paste between devices from your Mac
inthe macOS User Guide.

Universal Control

With Uriversal Cortrol, you can use a single keyisoard and mouse, or tracksad to cortrol mutiple devices. When you move tre pointer to the edge cf your
MacBook Pro screen, the pointer moves to your iFad o ancther Mac, so you can wotk aoross up 1o three devces,

Note.
To use Universal Cortrol, you must have macOS version 12.3 or later on your Wlac and iPadOS 124 o later on yeur iFad.

Check your connections.

Universal Cortrol on your Mac uses Bluetooth to detect another device and VWiFi to connect it Make sure eachdevice has Bluetooth turned onand is
connected to Wi-Fi, &lso make sure: Handoff is furred oninthe General setiirgs on your MacBodk Pro and in Settings = General = AiPlay & Hardoff on
your iFad. You must also be signed in with the same Agsle ID

on kooth devices, and have two-factor authenticati onturred on. When these setircs are corect, you can use Control Center o conrect your devices. On
your Mag, click Control Carter in the menu bar, click Screen Mirroring, 1hen croose a device g ow Link Keyicoard ad Mouse.

Mowe between screens.
On your Mac, USE your mouse or tracksad 1o move the pointer to the right or left 8dge of the screen o osest to your iPad, pause, tren move ta pointar
sightly past the: eedges of the screen. When a lborder appears at the edge of the: iPad soeen, comtinee moving the pointer to tre iIPad screen.

Drag and drop.
Select the text, image, or otter object you wart 1o move, thendrag it towhere you wart it on your other devces For examplg, you candrag a sketch youl
drew with Apple Pencil from your iPad to the Keynote apo on your MacBook Pro. You canalso copy somethirg on one device and paste it on the other.

Shidre a keyboard,
VWhen the poirter is in a dooumert or arywhere thrat you can erter ext and the irsertion paint is Blirking, begin twsirg.

Ledarn more,
See Usea kewir0ad Aand Mouss of trackpad Across davices with Universal Cortrol on Mac
imthe mac O3S User Guide.

Sidecar on your Mac

With Sidecar, you can tun your iPed irto a secord display for your Mac ard Lse your iPad as a tazistinput device for your Mac apes. Give yourself gxtra
FoACE 10 work, draw with Ap55le Pencil, mark Uiz PDFS and screenshots, and more,

Note:
Youl can use Sideca with iPad models that suport Ad e Percil and run iPaddS 13,1 {or | ater). For more irformation, see the Apde Supsort artcle Apple
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Ferci compatioility

Setup and connect.

Yol Can use your iPad wirelessly within 32 feet (ten meters) of your Mac, or cornect ¥our iPad 10 your Mac with a cade 1o keepit charged. To Set Up your
iPad as a second disglay, go to Apile menu [

= Systemn Settings, click Displays, then choose your iPad fromthe Add Disslay pop-up mend, Later, you can comnect to your iFad in the Disglay section of
Cortrol Center & .

To disconrect your iPad from your Mac, click the Sidecar button [T

inCortro Certer. Yol can aAlso tap &)

inthe sidekar of your iPad.

Set Sidecar settings.

Open System Settings, click Displays, then click the name of your iPad. You canthen specify Sidecar settings for your iPad, such as whether it is the main
digzlay or mirrors your WMac, whether it shows tre sidelsar and Touth ksar and where they are located, andif you can doulble-tap with Apple Pendl to access
ools.

Maote:”
If youhaven't set up your iFad, you don't see these ootions in Disday settings.

Extend or mirror your desktop.

When you connect your iFad, it aLlomatically ibecomes an extersion of your Mac desktop, 50 you can draj wour apps ad documents between your Mac
and iPad. To show your Mac screen on both devices {mirror the display), move your mouse over the Sidecar button 53

inCortrol Certer, click the right arrow that appears above the buttony then select Mirror Built-im Retira Display. To exterd your desktop agan, ogen the
menu and choose Use A5 Sepaate Display.

Tip:
For quick access 1o the Sidecar optiors. you can set Digplay setirgs [
10 d ways apoea inthe menu bar. Go 1o System Settirgs = Control Carter, then use the pop-up mau next 1o Displays 10 s8ect whether 1o show the
Dispaysicon inthe menu bar al the tme or only whenaci ve. vihen Sidecar is on and your iPad is comnected, the Display icon in tremenu ar chargss 1o
=.

Use Apple Fencil.
Precisely draw and Create in your favolite ioro 3335, JUSt drag e wird Ow from yolr MAac 10 yOLr iPad ard start Lsing A PENCil. Or use apde Pencil 1o
mak up PDFs, screenshots, and images. To leam more, see Continuity Seeteh and Cortinuity Manus onyour Mac

Note.
Pressure and tilt for &pople Fancil only worke in apiss with advarced stylus supicort.

Take advartage of sidebar shortouts.
Use the sidelzar on your i Pad 1o quickly reach commonty used buttons and controls Tap the buttors 1o undo actions, use keylizoard stortcuts, and display
or hides thes menu bbar, Dock, and keyboad.
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Use Touch Bar controls —with orwithout a Touch Bar.
For apps that have Touch Bar suppot, the cortrols appear at the lbottom of the iPad d solay, whether or not your Mec has a Touch Bar.

Learn more.
See Use your iPad a5 a second display for your Mac
inthe macOS User Guide.

Continuity Camera on your Mac

Cortinuity Camera on your Mac lets you use youriPhone as an addtiona camera for your Wiac. You can Lse your iPhore camera o make video cd's of to
take photos to insert themirto documents or savs them to your Mac

Maote

To use Cortinuity Camera as a welscam reguires an iPhone XR or newer. To Lse Cotinuity Camera to share photos, you néed an iProne or iPod touch with
105 12 (or laten) or an iIFad with iIPadOS 13.1 {or later) instaled. Make sure yoor MacBook Pro and IQS or IPad0S device have Wi-F ard Blusloothturred
0N and are signed in with thes same 40s 1D

Work wirelessly.

After you sat 4 Continuity Camera, your Mac can autormatically switch to using iPhone as a camera when itis inra-ge. You can also use a wired
connection if you prefer. See Choose anexterrd camera

inthe macOS User Guide.

Use yaur iPhone microphone.

Youl can also use your iPhone as a microphone for your Mac, Use the Videomeru in FaceTime to select youriPhone during a call or use aop settings to
SWitCh 10 YOUr iPhONE's miCrophone during video Cals, Yol Can also Use AUdio Setings inSystamn Setings 10 S8 ect your iPHONE as yolr Sysiem
microphore.

Use Video Effects,

When you Lse your iPhone’s camera to make video calls, you have access to video effects|ike Certer Stage, Portrait mode, Studio Light and Desk View,
Center Stage keeps 1he canera centered on you as you move, while Studio Light dims the backgrourd and illuminates your face, and Portrait mode blurs
the lzackground and keegos The focl.s on you. Wiith Desk View, wi-en you use your iPhore as a welbcam for your MacBook Fro, you can stow your face as
well as what'sin front of you. To use video effects, click Control Certer &

inthe menu bar, then sdect the effect you wart touse. iPEore 11 or newer is reguired for Center Stace and Desk View, ad iIF-0ng 12 or newer is required
for Studio Light.

Insert an image or scan
Use the camesra on your iPhong iPad, oriFod toLch 10 scan documeants or 3k a b cture of something nearkby. The image appears instaty o your Mac.
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Inan ap like Mail, Notes., or Mes5ages, sslect where you want 8 imace 1o go, ch-oose File (or Insert) = Insort From iPhore or iPad. choose “Tacg Photo”
or “Scan Documents,” then take the: photo or scan the image on your i0SoriPadO0S device. You might need to select your iOS oriPadOS device before
taking the photo. Tao Use Photo or Kees Scan. You can alse tap Retake if you warttotry agan.

Inan app such as Pages, seect where you want the image 1o ke inserted, then Cortrol-click, choose “Import imags,” ard take the photo. Youmght reed
o select your device before faking the photo.

Note:
To take a scan on your iS5 oriPad0S device, drag the frame until what you wart to show isin the frame, tap Kegp Scan then fap Save. Tap Retake to
rescan the content.

ssw e

Thes photo or scan appears where you wartit in your documert

eow M boarm

- Pap el
B = Warm Tovm
4 = Ligssiny & fuew

Learn more.

See Use your iPhone as a webcam

and Insert photos and scans with Continuity Camera o viac
imthe macOS User Guide.

Continuity Sketch and Continuity Markup on your Mac

With Cortinuity Sketch, you can uses your nearby iPhore or iPad to draw a sketch ad instartyinsert it into a dooumnerit on your Mac—for exampley inan
email, 3 message, a documert, or a note. Or use Cortinuity Markue to edit a document using your fingar on an i0S device or with Apple Pencil on an iPad,
and see those markuiss on your Mac.

Note:
To use Continuity Sketch and Cortinuity WMarkup, you reed an iPhone or iPod tolch with iOS 13 {or later) or an iFad with iPad OS5 13.1 (or later). Make sure
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youl're signed inwiththe same Apple ID
on al the devices, ard that they have Wi-F and Bluetooth turmed on Pressure and 1t for Apioles Pencil wotk only in apps with edwanced stlls support.

Insert a sketch,

Inan app like Mail, Notes, or Messages, position the poi rter where you wart to irsert a sketch. Chooses File (or Insert) > Imzort fromiPhone or iFad, then
choose Add Sketch. On your iQSdevice or iFad, draw a sketch usirg your firger or Aosd e Percil (on an iFad that supports i), hen tas Dones On your Mag
the skertch appears where you positioned the poirtern. Desending on wheare the sketch is irsarted, youcan ma kit ug enargeit, ad so on.

Mark up a docurnent.

With Cortinuity MarkLip, You can use a nearby iPad ()

or iIPhone/IPad toudh [

1o mark up PDFS, Scregnshots, and images, and 568 tre resulis on your Mac. Press and hold the Space bar o view the documert in Quick Look, then click
the device icon. If both devices are nearby, dick Arnatate B7 ,

thern choose a devices, The tool may appear highli o-ted o show your device is connected,

Start writirg, drawing, or adding stapes with your fi-ger or 8o e Percil (on an iPad that supports it). See the updates live on your Mac as you make them
on your iPad, iPhong, or iPod touch

G'._l;rvllum
& Smallae
Spaces

Learn more.
See Insert sketches with Cortinuity Sketch
inthe macOS User Guide and the Apple Supizort artid e Use Markup onyour iPHone, iPad, or iFod tolch

Use AirDrop on your Mac
AirDrop makes it easy to share files with nearzy Mag, iPhone, iIPad, and iPod touch devices. The devices dont need to share the same Agple ID

Note.
AirDrop for i0S oriPadCS requires devices that the device have aLightrirg or USB-C cornector and iG8 7 (o lazr o iIPadOS 13.1 {or later). hct al older
Macirtosh compLiers support AirDrop {for alist of supported computers, see e Apple Susport article Use ArDrop on your Mac

eve ; AlrDrop

Senda file from the Finder.
Cortrol—click the itern you want to send, choose Share > AiDrog, then sslect the device you wart to send the item o, Or click theFindericon &
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inthe Dock, then dick A Do N the sidelzar on theleft (or ckoose Go = AirDrop). YWhen the person you want to send afile to appears in the window, drag
the file to them fom the deskios or another Finder wirdow. YWhen you serd a fie to someone, the redpiert can chocse whether or not to accept the file.

Send a file from an app.
While Lsing an a3 like Pages or Preview, cick the Stare button ()
and choosea Airlvog, then select the device you wart 1o send the item to.

Control who cansend you iterns using AirDrop,

Clidk the Contrdl Certer icon@

inthe menu bar, dick AlDice @

then select “Cortacts only” or "Everyome.” You canalso turm Aidrop on or off Fere. iPad, iPhone, and iPod touch have s milar settings. Seethe Apde
Supicort article How 1o adjust AirDrop sethi mas

Tip:
I you don™ sae the recisient in the AirDrop window, make sure both devices havs Airllrop and B Letooth lurned on and are within 30 feet (8 meters) of
each other. if the recipientis using an older Mac, try dickirg "Don't see who you're lodking for?”

Receiveitemns using Airbrop.

When someone uses ArDrop to send anitem to you on your Mac, you can choose whether o accept and save it When you see the AirDrop notification
and want the item, dick Accept, then choose fo save it 1o your Downloads folder oran app like Photos f yoldre signed in on several devices wilh the same
iCloud accourt, you can easily send an item (for example, aphoto fromiPRone) from one device to arother, and t's saved adtomati call v

Shiare passwords stored in iCloud Keychain

In Safali, you can use AirDrop 10 share an accourt password with ong of your cortacts, or with anothar Mac, iPhone, iPad, or iPod touch. From the Safari
menu, open Setings = Passwords, sdect the webste whose password yol wartto share, then Cortrol-click. Croose “Share with ArDrop,” then select the
personor device inthe AirDrop window to share the password.

Learn more.
See Use ArDrop on your Macio send fies to devices near you
inthe manOS User Guide and the Agple Sugport arlid e Use AirDrop on your Mac

Instant Hotspot on your Mac

Lost your Wi-Fi connection? With INstart Hotspot, you can use the Parsoral Hotsoot on your iIFFore or iPad 10 corect your MacBook Pro to theiriemet
irstartly—no password required.

Maote:
Persomd Hotspot require s an iPhone with i0S 8 (or later) o a callLlar-model iPad with iPadOS 131 (or later). See the Apsle Suppot aride Howto setupa
Fersord Hotspot onyour iPhone or iFad

- B O 2 TueOct18 2:41AM

Wi-Fi )
Personal Holspot

@) olivia's iphone

Preferred Netwark

= Home
Other Networks

Wi-Fi Settings...
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Connect to your device'’s Personal Hotspot.

Clids the Wi-F status icon %

inthe menu kar, then dick €@

nextto your iPhone or iPad inthe list {f you don't 568 16 ISt clids Gther Networks), The WiFi icon in the todsar chancesio (@>.

Yol don*t need 10 do anything on your devicE—MacBook Pro conrects astomatical . Yehen you're not UsiNg the hot3pot, your MacBook Prodiscomiects
10 savs battery life.

Tipx:
f you're asked for a password, make sure your devicess are setup correctly. See the Apple Support article Use Instart Hotspotto connect tovour Personal
Hotspot without entering a jpassword

Check the status of your connection
Lock inthe VWi-F status menuio see the stremcthof the celiula sigral.

Ledrn more.
See Use an iPhone or iPad 1o connect to the Intemet
imthe macOS User Guide.

Phone calls and text messages on your Mac
With a Wi-Fi conrgction, you cantake cals—and make them—righ-t from your MacBook Pro. You can also receive and send text messages.

Set up FaceTime for phone: calls.

On your iPhora (0S 8 or 1ater, go to Settings > Phong and enazle Wi-Fi calling. Then, on your Mac, opéen FaceTime Go o Settings, chooses General, then
click *Calls from iPhone.” Sae Sat up your iPhore and Mac for shore calls

inthe FaceTime User Guide.

Q &+ TueOct18 9:41AM

Olivia Rico 01:34
g |1 1 [T LT CETHTHTRCT AT TR T LT 11

M Video & Mute

Make a call.

Open FaceTime o your Mac ad click Create Link or New FaceTime. Create Lirk wil gererate a lirk that you can share using AifDrop, Mail, Messages,
Notes, or Reminders. New FaceTime allows you o eter a rame, emall, or phone rumier. You can also start a FaceTime call in Contacts. Click the ghone
icon %

inthe FaceTime rowy for a cortact, You can aso click a thorenumier in a Spotlight search o in an app sueh as Safan o Caerdar {your iPcne o iPad
with a cellular comection must be nearby). See Make ard recsive phone calls in FacsTime

inthe FaceTime User Guide.

Take d Cdll.
When someone calls your iPhore, click thes notificat onthat appears onyour MacBook Pro screen. Your MacBook Pro beccmes a sipeakerprone if you're
rot wearing headphones.

Tip:
To temporadily turn off notificatiors about phone call s, messages, and more on your Mac, turn onthe Do Not Disturb feature. Qlids the Cortrol Center icon
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inthe menu Ear, then dick Focusand choose a time imit.,

Send and receive messages.
Use Messages tosend text messages from you MadBook Pro. Al messsages agpear on your MacBook Pro, iPhone, iFad, iFPod touch, and Agple Watd, so
when someomne texts you, you can respond with whichever device is d osest, See Messages

Ledarn more,
See Set up iPhorme to get SIS texis on Mac
inthe Messages User Guide.

Share experiences with SharePlay

With SharePlay, you and your friends and family can listen fo music, walch TV and movies, or view contert together while ona FaceTime call Start a real-
time watch party with friends, ched< out a new muSsic release together, skhare a video of song with your fiencs in Messages, or shae what's on your soreesn
and tak asoutit. Your fiends can part dpate on their iIProne i 0S 15 or later), iPad (iPadOS 15 o later), or Mac with macOS Morterey or later installed.
Youl can also watch cortent on Apple TV (tvOS 15 or later) wi-i e chatting with your friends on another device.

Note.
Some apps that supsort SharePlay require a subscristion toparticipate: Mot all features and contert are avalalde inall counties o regiors.

Begin with FaceTime.

Start aFaceTime calk irvite your friends, family, or colleagues, ard then use ShareFlay /72

1o share an experience with them You can also add a StarePlay link to a thread in Messaces. Take advantace of the new features that make FaceTime
caling even better —grid view, Spatid Audio

{wich spreads out 1he voices 5o ey sound |ike they're coming from whigre your fiends are positiongd), and voics Ealation (which spotlights your vaice
and minimi2es background Noise).

-

Sl=iallvu @

Watch together.

Bring movies, TV show s, web videos, and more irto your group FaceTime calls, and enjoy the: commection with others while watching video together. i you
pause, rewind, fast-forwards or skip fo adifferert scene everyone's playizack remains in syra Viithsmart volume aLdio is adjLsted aLtomatcally so you
can cortinue 1o chat whi & watching.
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Listen together.

Share music with your fiendsright in your FaceT me calls, or host a full-blown dancs party. Vren listering together, anyone on tre call can add songs to
the shared queue. Tre playizack cortrols are shared by everyore on the call and, by listerirg with smart volume, you ard everyone else can chat without

having 1o shout

M e e B ey e Ceee bt i e

Shiare your screen

Use SharePlay in FaceTime 10 bring welsages. 3505, and more into your corversation, Arything that appears on your screen can be part of a shared
moment. Browse vacation rertals together, shop for bh cesmaid dresses, teach a new skill, or give animpronpiu slideshow inPhotos. Sdecta single

window to share, or share your whole screen.

DT e pem—— e

M “Blitiex Park: Public Climbing Wal
= Uplift Architects

Learn more.

Start with FaceTime
Jthensse TV

and Music

Subsaripl ko et e karfpph V-

Use AirPlay on your Mac
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Show whatever's on your MacBook Pro on the i g screen using &ifPlay screen mirror ng—or Lse AirPlay to send cortent o your Mac from an iPhore, iPad,
or even another Mac. To mirror the MacBook Pro screen on your high resal ution TV screen o o use the high resolution TV a8s a second display, connect
wour high resdlLtion TV to Apple TV and make sure the Apple TV is on the same Wi-Fi network as your MacBook Pra. You canalso play web videosdirectly
on your high resolution TV without showing what’s onyour desktoz—handy when you warttoelay a move but keep your work private,

Mirror your desktop using Screen Mirroring.

Clids the Contrdl Certer icon @

inthe menu bar, dick Screen Mirroring ©) ,

ther choose your Apple TV VWhen AilPlay is active, the icontrrs blue

Note:
I your Mac susports AirPlay 50resn mirroring, yolu 568 an AirFAay statusiconin themery bar of your Mac when an Appla TV is on the same network as
your Mac. See the Apple Support artide Use AirPlay to stream video or mirror your device's soeen

1IN 50mMe cases, you can Wse an AirPlay disdlay even if yoLr MacBook P ism't onthe same Wi i network as Apde TV (called peer-to-peer AirPlay
). To use peer-to-peer AirPlay, you need an Asple TV (3rd generat on rev A, mode! A1483 or later) with t+vOS 7.0 or later

Send content to your Macfromn cther devices.

WalCh videos, iSten 10 MUSIC, aNd More 0N yolr WAC as they're BEING PlaySd 0N ¥OL- Oher deviCes. MImor your iPhong or iPad On yold Mac o exterd s
disslay by using your Mac as a secondary display for agss that sugoort it, such as Keynote ard Photos. Use your Mac as an AirPlay 2 speaker to stream
music or podcasts to your Mac, or use it as a secordary speaker for multiroom audio. Your Mac works with any Apde device, and it's even easier o
connect if the devices share thes same Apsle 1D

Play web videos without showing your desktop.
When you find a wels video with an AirPlay icon L],
click the icon, then salect your Appie TV.

Tip:
If the imag e dossn*t it your high resolution TV screen when you mirror thes screens agjust the desktop size forthe best picture. Qlidk the AirPlay icon [
inthe video, then choose an ootion under “Match Desktop Size To.”

Bople TV s sold separately at apple.com
or your | ocal Apple Store.

Ledrn more.

To learn more about AirPlay, see Use AirPlay 1o stream what's on your Mac o an HDTY

inthe macOS User Guide. To learn more alout us ng a second disd ay with your MacBook Fro, ses Use an external dsolay wit your MacBook Fro
» To troubleshoot, see thes Apple Support artid e If screen mirror rg or streanirg isn't workirg on your ArPlay-compat He device

Sl R v W fEOARER V-

Unlock your Mac and approve tasks with Apple Watch
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Vhen you're wearn ng your &pple YWatch, you can use it 1o automatical y unlock wour MacBook Proand approve authentication tasks— such as ertering
passwords, unlocking notes and settings, and althorizing installations—witholL.thaving 1o tyoe a password. These features use strong encryition 1o
provide secure communication between your Ao e Watch ard MacBodks Pro.

To use the Aute Unlock and Approve with Aoidle Watch features:

L]

Sign in on your Mac and Agzle Watch with the same Apple ID

o Make sure your Apple Watch is unlocked and running watchOS 3 or later to automaticaly unlods your Mac; approvirg autherticaton requests reguires
watchOS B or | ater.

e Tum on two-factor aLthentication (see below).

Set up two-factor authentication for your Apple ID.

To turn on two-factor authertication

, 0pen System Settings, click your Apole IDiN the sidebar, o ck Password & Security, then selgct Sat Up Two-Factor Authartication. S8e the Apd e Support
article Two-factor auihentication for Apple ID

Make Sure “Disad e A_0omatic 1I0GiN” is as0 selected (You worTt 588 this option if you're using FileVault, but you Can still use & “ALto Uriock™ and
UADProve with Appie Watch” features. For information about Filgvall, See Enayit MAc data with Flevauit
inthe macOS User Guide.)

Set up Auto Unlock.

Sign in on all your devices with the same Apple D

, Then open System Settings

on your MacBook Pro, Click Touch ID & Password in the sicielar, tren fum onthe unl oclg settirgs for Apple Watch,

Note.
These features work onby when your Apple Watch is autherticated witha passcode. You acthenticate your Apple Watch eadh fime you put it on, so no
extra stegps are necessary after you erter your passcodes

Skip the sign-in.
walk up to your slesping MacBook Pro wearing your autherticat=d Apple VWatch on your weist, ard lift the cover or press a key to wake your MacBook Pro
—Apple VWatch unlocks it so you can get right to work.

Approvewith Apple Watch.
if you're promoted for a jpassword, doude-dick t-e sides button on your Apple Watch to auttenti cate your password on your Mac. You can view your
passwords in Safad, apsrove aop installations, unlods a locked note, and more freguires watchOS 6).
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Learn more.
See Urlock your Mac and approve reguests with Apple Watch
inthe macOS User Guide.

Use Apple Pay on your Mac

You can make easy, secure, and prvate purchases on webstes using Apple Pay on your MacBook Pro. With Aode Pay, your 8ople Cadand ofer credit
or dedbsit card irfornation Is mever stored or shared by Apple with tre merchant, When you stop onling usirg Safar, look for an Apd e Pay checkout option.
Corfimn payment using your Touch 10, vour iPhone or Amole Watch,

Mote:

Aople Pay and Apple Card aren't availalde in all countries o reg ors. For irformation asout Apple Pay, golo Apple Pay
. For irformation about current card issuers, see the Apple Sugport artid e Aigsle Pay participating banks

. For irformation about Apple Card, see Agple Card Support

- o~ N -
\ \ )"\ { _r‘ e HE
SR i : i [ ]
£167.61
Set up Apple Pay.

Apnle Pay uses the Apple Card of other credit or debit cards you've already set up on your iPhore or Aople Watch, 50 N0 extra selupis required. You must
be signed iNto an iPhone or AxsleVvatch that has Apple Pay Setup with the same Apple ID

you're using on your MacBcok Pro. The default payment card, shipping, and contact informati on that’s set on your iPhone o Apsie Vwatch is used for
purchases on your Mac. i you hava no dabit or credit cards set up on your iPhone or Apple Watch, you can do itin tre Wallet & Agple Pay settingsin
System Settings

Make a purchase using Touch ID.
On your 14-inch or 18-inch MacBook Pros you're promisted to configure Apple Pay during setup. When you choose Apde Fay ona wessite, dace your
fnger lightiy on e Touch ID sensor o avthenticate and complete your purchase.

Make a purchase using the Touch Bar on 13-inch MacBook Pro.
When you choose Apple Pay on a weksite, the merchant name ard purchase amount agioears onthe Touch Bar Place yolr finger lightly on te Touch ID
SEMS0r 10 Aut-ertiCate and CoOMplete your purchases,

Make a purchase with iPhone or Apple Wakch.

Clioe the Apple Pay bLtton on the website, then 1o confirm the paymert, use Face 1D, Touch Dy or the passcods on your iPhong, o doude-click the side
button on your urlocked Apsle Watch. You must be signed into aniPhong or Aozl Watch that has Apde Pay set up with the same Apsle 1D

yolr're using on your MacBcok Pro.

Maote
Youl can add or deletes payment cards and manacge your Apid e Card in the Wall et & Apple Pay settings of Systemn Settings
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Ledrn more.

See the Apole Support artid es Sat up Apcle Pay

. Make purchases usirg Apple Pay

, ard Change or remove the paymert cards that vou use with Aople Pay

Use AirPrint on your Mac
I youhave an ArPrrt-enald ed printer, you can print photos ard documerts from your Mac witholt Faving to dowrlcad and install printer drivers,

Yol can Use AirPrirt to print wiralessly to.
e An AlrPrint-enakied orinter on your Wi-Fi networi
o Aretwork Bimter of printer shared by ancther Mac on your VVi-Fi networg

e Aprinter connected to the USE port of an AirPort base station

Print to an AifPrirnt printer.
When you print from an app, click The Printer pop-up menu in the Frirtdialog, then choose a grirter in the Nearioy Printers list

Car‘t find the printer you're looking for?

Make sure its connected to the same Wi-Fi netvork as your MacBook Pro. If it’s connected and youl still dor't see it, try adding it open System Setirgs
, clids Printers & Scanners in the sidebar, then click Add Prirter, Scanner or Fax on tre rght. (You may have to temporarnily comnect the printer to your
MacBook Fro Wsing 2 USB cable and, i f necessary, an adaster)

Ledrn more.
See Print wirglessly from your Mac to an AirPrint printer
inthe macOS User Guide,

FOr Alist Of AiPYiNt-Enaiied prirters and other SUpported printers, See the Appie SUgoort artid e Alsout AirPrint

Apps

Apps on your MacBook Pro

Your MacBook Pro comes with a collection of great apps for things you do every day, like browseg the web, stay conrecied with Messages and FaceTime,
and manage: your calendar. it also comes with apps like Photos, Apsle Music, Apple Fodcasts, the Apple TV app, Fages, Mumbers, and Keylote—s0 you
can be creative and productive right from the start.

Maote”
Some macOS aops ae retavailasle in every region or languace.

Where dre my apps?

Yol can find the apps inthe Aodlications folder inyour Finder wirdow. You can open apps fom tre foldar or drag them to your Deck. This fdder includes
a subfolder, Utilities, where you cam locate Disl Utility ' =,

Keychain Access B,

Migration Assistart & ,

VoiceOver Utility &,

and other useful Ltilities.

Here are some of the apps that come with your Mac. Click tre aop name to leam more.
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leon/App name

App Store

FaceTime

Garagegand

Keyrole

Messages

MacBook Pro Essentizls

leonfApp name

Books

HOome

Wlusi c

lcon/App name

e

Calendar

Freefcrm

MEDSs

M s
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leon/App name

Reminders

SHOCHS

Youl can find additional gops that are not listed in tre tasle asove—like CalcLlator &

Chess 8 ,
Clock @,
Cortacts @,
TextEdit /.
Weather B3,

and more—in the Apslications folder.

Ledrn more.

For alist of dl the apps and tilities instdled on your Mac, sse Apiss included onyouw Mac
inthe macOS User Guide.

Find even more apps.
Clide the Ao Store icon &

MacBook Pro Essentizls

leonfApp name

Murmniers

Podcasts

T

lcon/App name

Preview

Srortcuts

Ydoe Memos



inthe Dock 1o find and cownload aops for almost everythirg you want 1o do. To |earm more, 568 Aop Stors

Get help for any app.
Clids thes Heslz menu (in the menu kar at the top of the screer) when you're using an app. See Use the macOS User Guide

) App Store

Search the App Stores tofind and download azps, and get the latest updates for your apos.

Find the perfect app.

Krow exactly what you're Icoking for? Tyioe the app rameinthe search feld, then ppress Return. Apps you download fron the App Store aopear
automatical ly in Laurchisad

. O you can explore mew apps by choosinga a2 in the sidelbsar, like Create, Work, or Play, and brows rg through the results.

(Click a tab to browse apps.

Search for an apg by name.

o

Fobow the Sand

Maote-
Anole Arcads is not avail asle in al coLntas or regions.

Ask Sird.
Say something like: “Find aps for kids.”

Al youneed is an Apple ID.

To download free apos, sign in with your Apple 1D

—click Signinat the ottomn of the sidebar in Az Store. If you dom't have an apdelD

yet, gick Signin, then dick Geate Apple 1D, If you have anagsis 1D BLt dorft rememiser your sassword, Click “Forgot Ample ID or password 77 10 recover
it. You must also set up an account with purchasing informationto bLy feebased aigss.

Use iIPhONe and iPad apps on your Mac.,
Mary iPhone and iPad apps work 0N your MacBook Pro. Ary avalable apps that you previously purcHased for your iPHcne or iPad gapear on your Mac.,
Search for aops in the Azp Store 1o ses if they're availazl e for Mac.

Game on

Clige the Arcade tab to learm howy to suibscribe o Agple Arcade discover cames yol can [day, find ores that are popua with your Gamne Center friends,
seeyour achievernert progress, and more. Games you dowrload from the Aop Store appear aLtomaticaly inthe Games foderinLaunchpad

, sothey’re always easy 1o access, evenwith a game controller. See Subscrioe to Aod e Arcade in the App Store on Mac

inthe App Store User Guide and Apple Arcade
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Save your game aclion
You can save up foa 15-second video diz of gamepslay by pressing the share lutton on sugsotted third-zarty game cortrollers, so you canreview your
game strategy or keep a record of memorable gamingmomer-ts.

Invite your friends to play.

Thes new muttiplayer friend selector makes it easy 1o irvite your recent Messages frierds and groues to Hay Game Certer-enalbsled games. See incorirg
requests and irvitations inthe friend reguest inbbox. See Play cames onyour Mac

inthe macOS User Guide.

Get the latest app updates.
If you see a badge on the Azp Store icon im the Dock, there are updates avallalde. Clids the icon to open the Aop Store, then click Updates in the sidekar.

You have
|a\railable updates.

Use the Touch Bar on your 13-inch MacBook Pro.
Tap abuttorto quickly move to the tals you want (Discover, Arcade, Create, Work, Ray, Develop, Categores, or Updates).

Ledarn more.
See the App Store User Guide

.. Books

Use Apfie BODKS 10 read ard OrgaMiZe your lisrary Of bO0KS and audio i500ks, and 10 [furchase New Books 0N yolr MAC. Set reading GOAS ard kesp track
of what you want to reead and what you're reading now.

Maote”
Aople Books is not available in all courtries or regions.

A bookshelf on your Mac.

BOOKS yol/Ve Started redding aiopear at the 10 in Reading Mow. BrowSe or Searth all the fEmSin yollr lisrary— OF Click BoOk SiDre o ALIOK00K Store in
the sidebar and chocse a category to find new books and otrer pLdications. To buy an item, just sign in with your Agsle ID

{choose Account = Signir). You can also buy books right from the search resulis,

Ask Siri.
Say something like: "Find books by Jare Austen.”
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Type what you're looking for.

Books fra

[ ®rnal |
Luiecomer

LiL!

|l

JOHN
GRS =

View your books and fists.

Set reading goals.
Set daily reading goals 1o motivate yoursel f 1o read more. The defautis 5 minutes a day, butif you wart to amhigher, click =

irmthe Reading Goals section of Reading Now and choose a rew goal You can tum this off and clea reading goal data in Books settings-

Add bookrnarks, notes, and highlights.

Move your poirter to the o of the ook youre read rg to show the controls, then clic B

1o bookmark a page (click the tookmark again to renove the bookmark). To go to albookmarked page, sFow the cortrd s, dick 9,

thenclick the ibookmark. To add notes or highlights, sa ect the text, then choose a Fighlig-t calor or Add Note frcm the pog-up menu. To read your rotes

later, show the cortrols and click &

Never lose your place or your markups.
Your purctased books, collections, bookmarks, higHigh-ts ard rotes, and the currert page yolfre reading are avai lad e automatically cn yourMac, i0S
dewices, and iPadOS devices, as |0Ng a5 ¥oU're S gNed in ontem witttHe same ASpie 1D,

Use the Touch Bar on your 13-inch MacBook Pro.

Tap )

or ¢

o navigate back or forth in the Book, or use the scrutoer to move guickly through the pages. Tao &,
1o search, or tap [

10 add a bookmark 1o the current pages.

Tip:
Change 1o Nigt-t heme 1o read more easily in low-light situations. Choose View > THETE, then choose MNight, or click he Appsarance bution AA ,
thenclick the black cirde. kot all books sUpEort Might themes
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. . ~— Use Night theme.

Athelas

San Franc

Proxim:

Learn more.
See the Apple Books User Guide

[ oot Y
12 Galendar
Never miss an aspointment with Calendar. Keep trade of your LSy stheduls oy creating multiple ca endars, and manace themal in ong place.

Credte events.

Clige +

o add a new evert, or dousle-click anywhere in a day. To irvite someons, doud e-dick the evert, click the Add Irvitees sectiony then type an email
address, Calendar lets you know when your invitees reply.

O ask Sini.
Say something likes *Set up ameeting with Mark at ring in the momirg.”™
Show the Create a Change the
(calendar list, new event, calendar view,
L] L] -_ 3 4 & Weew g w - 13

October 2022 ¢ Tl 3

Mon 17

Thu 20 Frin

sl ¥ lw-qu.-..-.‘...

Uhusact Westina

Tip:
If youadd alocation to anewvert, Calendar shows you a mas, estmated travel ime ard time 1o leave, and even the weaher forecast,

Acialendar for every part of your life.
Create sgparate caerdars—for examgle, for home, worlk, and school—each withits own color. Choose File » New Caendar to create acalerdar, then
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Cortrol-click each calendar 1o choose anew co or.

eve B &

2 Personal OCtO ber 2(:

Family

Share Calendar...
Schoo

Delete
Merge >

@ Birthdi
@ L

Custom Color...

Siri Su

Add holiday calendars.
View holiday calendars from differert regions around the world. Choose File > New Holiday Calerdar, tren choose a hol d ay cdendar you wart to acd.

See allyour calendars—or just a few.
Cligs the Calendars kbutton to see a list of all your caendars; click the ones you wart to 5ee int-e wirdow.

Filte ryour calendars with Focus.

Choose which calendars fo show during a particLlar Focus: For exampley have a calendar with assignment due dates that fums on orly while studying.
Choose Apple Meru > System Settings, then dick Focusin the sidebar. Select a FocLs onthe rig click )

and choose Add Filter under Foous Filters, To leamn more azout addirg o customizirg a Foous, 562 Set up a Focls on Mac

Shiare across your devices and with others.

When you're sigred in 1o iCloud, your caendars are kot us to dates onall your Macintosh complters, 05 davices, iPad0S devices, and Apd g Watth that
are signed in with the: same Apple D

. You can dso shae calendars with otter iCloud users.

Use the Touch Bar on your 13-inch MacBook Pro.
Tap e Today outton to view or edit today’s events, or use the slider to salect the morth—past o future.

Learn more.
See the Caderdar User Guide

« FaceTime
Use FaceT me to make video and audio calls from your Mac to afriend or a group of friends. You can also use your iPhone or iPad wilh your MacBook Pro
inrew ways with FaceT me, by handirg off calls betwesn devices or Lsing your iPhone camera as a webcam.
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O ask sini.
Say something like: "WMaks a FaceTime cdl to Sharon”

Make a FaceTime call.

Use the built-in FaceTime HD camera on your Mac 1o make FaceTime video cal s, Click New FaceTime, erter a rame, thore rumben, o emal address for
the person you wart to cal, then click FaceTime. K ifs not conveniert 1o make a video call, click the pop-up meru and select FaceTime Audio to makean
aud o-only call. ¥When youl recaive a FaceTime invitation, yol can chooseto join with video o just abd o,

Tip:
While a wideo call is in progress, vod can drag the smal @ cture-inqai ciure window to ary corngs of #e FaceTime wird ow.

List of recent calls

Hand off a FaceTime call.
Start aFaceTime call on your iPhore when you're oLt of tte house, then hand off that call to yolur Mac wihen you're back at your desk Or take aFaceTime
cal from your Mac, and switch 10 another device when you need 1o. If you have Bluetooth headohores connected, they make the switchioo.

To hand off a FaceT me cal from your iPhone or iPad to your MacBook Pro, dick o

inthe menu ar on your Mac, dick Switch, then dick caininthe FaceTime wirdow on your MacBook Pro. Tohand off a FaceTime call from your MacBcok
Proto your iPhone or iPad: tap (1

inthe usoer left of your iPhang or iPad, 1ap Switch, then tap Switch again.

AEOFsEDSaPER-TREFNEER

Use yauar iPhone as a webearmn

Harness te power of your iPhone camera for FaceTime calls on your Mac. Keep your iPhone stakde and in landscapse od ertation—for exanole, placeitin
a stand—wvith thes soreen off and tres back cameras facing you. Chyour Mac, go toFaceTime = Video, then sd ect your iPhone from te list. On iP-ones 11
or newer, the Ultra Wide camera allows you 1o use Certer Stage, which meansthe call stays cartersd on you 8s youmaove. You Can choose other video
effects by clicking 8

inthe menu kar, dicking Video Effects, then choosirg from the options, like Portrait mode. See Use video effects on your Mac

to l=am more:
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Shiow whiat’s in front of yow

With Desk View, when vou Lse your iPhone as a welscamn for your MacBodk Pro, you can not orly show your face, lbut can share what’s in fortcf vow To
share with Desk View in a FaceTime call, set up your iPhone as a welbcam, then click Desk View in e upser right of the FaceTime wirdow on your Mac.
Or click 8

inthe menu Bar, dick Video Effects, 1hen choose Desk view, LS the cortrols 10 align your desk 1o the windowy, t-en click Skare Desk View, To 5top sharing
Desk View, dick @

on the Desk View window. Desk View is avalabe on iPhore 11 or newer.

Note.

To hand off a FaceT me cal or use your iPhone as a weltcam for your Mac, you must Fave Contiruity Camera tumed on in Arflay & Fandoffsetings on
wour iFad or iPhone, and you must Be signed info your iFhong, iPad, and your MacBook Pro with the same Apple ID

. Your iPhore, iPad, and Mac need Bluetooth, WiR, and Handoff tumed on For addtiond reguiremerts and to leam more, see Use youriPhone asa
wELCAm On your Mac

Use FaceTime with a group.

Yol can cornect with up 10 32 ieosleina group call, WMake a unigue link to share with a group. Clide Creete Link. Copy thelink to your Clipkboard orshare
directy with friends in Messages or Mail. You can now use alink o jon FaceTime calls on non-A55l e devices

Tip:
Add a FaceTime link to a Calendar event 1o schedule a call for later.

Sign language recognilion and Live Captions.
FaceTime detects when a participant is using sign larcuage and makesthe person prominent in a Group FaceTime calk FaceTime Live Captions delect
what’s sad and present real-time capti ons for the active speaker.

Watch and listen logether.
Use SharePlay towatch and listen together on Mac. You can also share your screen duirg a FaceTime call. Qids the StareRay icon 780
1o start, See Share expariences with SharePlay

Maote
Some apes that Supsot SharePay redLire a SUBSCHiStion o particisate. kot all features and contert are avalade inal countries o regors.

Make a phone call,
If youhave aniProne withiOS 2 or later, makes phone calls from yolr Mac usirg FaceT me, Just make sure that wour Mac and iPhone are signed in with the
sameE Apple ID
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accourt, and that both have thes feature turmed on (Onyour Mag, open FaceTime, croose FaceTime = Settirgs, then seect *Cals from iPhore.”)

Maote,
Your MacBook Pro and iPhone must be connected to the imtemet and thes same Wi-Fi réetwork to make or receive cals on your Mac.

Use the Touch Bar on your 13=inch MacBook Pro.
When starting a new FaceTime call, begin typing a cortact’s namein the To fisdd, then 130 the contact when they appear inthe Touch Bar. On the Touch
Bar, choose Aud o or Video for the type of cdl youwant tomake,

Learn more.
See the FaceTime User Guide

©@ Find My

Use Fird My to locate your friends, family, and Agple devices—4l in the same app.

Locate your friends,

devices, or items.
[
. e ¥
. Dy Bamirea. ;
a i Rl a L
’ s SE
By Asiey o ; :
=] “+ San Franciseo
P
i
0
o
Note.

Fird Wy features are not avalaile i all regions or larguages.

Share locations with friends.

IN e FEOHE liSt, Click SHars My LoCation 10 18l fiends and family whSre YOu are. Yol CANShare yold live 10Cation for a1 hour, a day, or indefiriely, ard
storz sharing whenever you like. You can also asik o Tollow a fr erd so you can see where they are on amap ard get step-oy-step directions to treir
location.

Bet [ocation alerts.
BAutormatically send notifications to friends whenyou arrive at or lgave a specific location. Set notificatiors when your fiends leave and arrive, too. fyour
friends create notifications alsout your location, you can view themall in one place—dlick Me in tre Feople list, then scrdl o Notificatiors Albout Yow

Get notified when you leave something behind.
Set Lo separat on derts on your iPhone, iPad, or iPod touch to notify you when you leave yolr MacBook Pro or another device behind To sst up

segaration alerts for a devices, dick
for the device, then choose Noti fy VWhen Left Behind and follow e orscreen instructions.

MacBook Pro Essentizls 68



Secwre a lost device.

Use Find My 1o locate and protect missing devices, ke your Mac, iPhore, or AirFods. Oick a device in the Devices list to locatz it onthe mas Qlick |

1o see options like play a sound on the device to helis you fird i, mark e device as lost so others can't access your persoral nformation, and even erase
the device: remotely.

_f{'“; '.-".Z‘ Loop

Danny's MacBook Air  —

Locate devices, even if they're offline.

Fird My uses Bluetooth signals from other nearsy Apid e devices o |ocate: your device when it's not connected toa V-Fi or cellular networs. These signals
are anorymols and encrypted, and help locate your missirg device withol t comzomi s ng privacy. You can evenfind a device that's been erased (for Mac
computers with macOS 12 or | ater, iPronss and iPod touch devices withiO5 15 or later, and iFads with iFad0S B or later).

Find a family member’s device.
You can use Find Iy fo hels locate a family member’s device, if yollre in a Famiy Sraring group ad your family member is sharing their location with you.

Find everyday itemss.

Aftach an AirTag to an item like your keychain to guicklylocate it when you cari fird it Use your i0S or iPadOS device to regster an AirTag and
compatible third—party items to your Apple ID. To locate items using your Mac, click e tems tabin Find My, Then dick anitem inthe list o viewr its
location on the map. i theitem car't £ |ocated, ¥ou can i ew its | 35t Iocation ard receive a notification when the item is fourd. Yol can even tum onbLost
Mode for an item that includes a message and hone numier. See Locate an itermnin Find hy

inthe Find iy User Guide.

Ledrn more.
See the Find My User Guide

& Freaform

Use Fre@form 10 OrganiZ€ ideas and Collaporate with Others. Create @ board, then add text, media, files, and mors. Cdlazorate and 588 CHanges in real
times.

Note,
Freeformis avalable on macOS vertura 13.1 or later.

Create a board,
Cligs thee New Board button in the toolksar to create a new board. Boards are saved adtomaticaly. To name a board, click Urtitled in e top left of te tile
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bar and eer a name.

Tipx:
Your boards sync across your devices. If your boards are not syncing, Turnon Fresform in iCGlold Settirgs. Freeform is availalde on iQS16.2 and iPad0S
16.2 or later.

Add text, media fles, and more,
Use the toolbar 1o insert text, sticky notes, photos, links, ard filés foyour kboard. You can also drag items to your board from ott-&r apos.

Organize your board.
You Can move, resize, grous and algn items on your board. You can d 5o view your izoard with a grid or use aignmert guides 1o hd p you podtion tems

Collaborate: in Freeforrn.
You can serd an invitation to collasorate on a board in Messages o Mai, or copy and share tre link. Click
inthe toolbar, choose Collaorats, then select Messages, Iail, or Copy Lirk if yousiare in Messages, evaryone on the threadisirvited to te ksoard,

Export as a PDF file.
Youl can exgort a Freeform bboard as a PDF file Choose File » Export PDE

Learn more,
See the Freeform User Guide

# GarageBand

GarageBand is an apo for creating, recording, and shalirg your music. It has everything you need 1o isarmn 1o play an instrumert, write music, or record a
S0Ng—YyoLr own home recording studio-

Create a new projecl.

Yold Can Start with A S0NgG 1EMpIats, 58 ect 31830, key, and Other GGHoNs, then olick RECord Ard start DIaying. Bulild ¥or S0Nng—for Sxampls, with
differert tracks and loops. Cidk Quick Hdp @

and hold the poirter over items 1o learn what they are ard Fow trey work,

| Show Smart Contraols, Wiew Apple Loops.

| View Editors, Tracks area Qpen the Note Pad,

- - Pt i T

{mact

i
ks

Bring in the beat.

Yol Can gui ckiy add drums and other instrumerts 1o your project Usirg Loops. Click the Loop Browser O,

find a loos by Instrument, Gesnre, or Desscriptor, and then drag it into an emipty part of the Tracks area Youcan customize Loops to fit your song,using a
smple set of contros.
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Record your voice.

Choose Track = MNew Track, then select the microptore under Budio. Click the tiangle next fo Detals fo set options for inpLt, oLteut, ard moritoring, then
click Create. Glick the: Record button @

10 start recording, oF the Play budton »

10 stOPs recording.

Click to record your voice.

Choose a track type

concel (DR

Hear yourself while you record.

Use the Touch Bar on your 13-inch MacBook Pro.
Easily adiust the Smart Controls for a selected track. Tas buttons to quidely fire-ture te sound of your instrumert, tum effects on o off, or adjust the
volume: of your track.

Learn more.
See GarageBand User Guide
and GarageBand Support

Home
With the: Home aoio, you can easily and securely cortrol all of your Homekit accessori es from your Mac.

Whole-house view.
See your ertirg home at a gancein thes redesigned Home tab, ird Lding camaras, SCenss, and acCessonias grouped by room. An updated Sidehar layolt
also includes categories and rooms so you canget tothemguickly.

Accessory control.

AcCESSONes aopear in the Fome app astiles with icors. Accessory categories are visLaly recognizakd & by color and you can choose which files to enlarge
so they are more prominent in the Home tab. Clids an accessory e to cortrol it—1um lights onor off, lodk or urlode the deor, open or close the Hinds,
and more- You can also adjust the rightnesss of a lig-t, or the target temiserature of a thermostat.

Categories.
Categories for Lights, Climate, Security, Speakers ard TVs, and Water let you quickly access al the rd evant accessories orgarized by room, dong with
more detailed status irformation.
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Categoriesl

‘Click an accessory to controf it.

Shidred ACcess.
You can share your home with family memisers, so they can cortrol accessores Lsing the Home app on thar own Apple devices,

Credle a scene,

Create a scene that lets your accessories work together with a sirgle command. For examsle, make a Good Night scene that turrs off all the lights, closes
the shades, and locks the: door when you turm in for the night. To create a scere, click +,

thenclick Add Scene

View your cameras.
Conrnect your home security cameras in the Home: apis 1o record your footage and view it from anywhere. Up 1o nine camera views are displayed front and
center inthe Home tab and it's end-to-end encrypted.

HomeKit Secure Video.

Store wideo from home sescurity cameras in iCloud, and nore of the video counts agairst your i Cloud storage. Defire actvily zones within a camera’s view
10 capture video of receive notifications only when molion is detected in those areas. In addition 1o person, arimal, |packags delivery, and vericle detecton,
Face Recognition | ets security cameras and dooricals identify people you've tagged imthe Photos app or in tre Home 3op as recart visitors, Homekit
Secure Video requires a supsorted iCoud plan, compatible HomeKit-enabled searity camera, ard HomePod, Apple TV, or iPad runvirg as a home hub.
See the iCoud User Guide

Adaptive lighting.

Set ywour smart light boulbs to astomatically adjust the color temperature throughout te day tomax i ze conmfort and productivity. Wake uo to warm coors,
stay focused and alert midday with cooler ones, and wind down at night by remosing blue light (Adagtive lighting reguires a home huls. For more
irformation, see Corfigure a router 1o Use with Home on Mac

inthe Home User Guide,)

Learn more.
328 the Homes user Guide

® iMovie

iMovie lets you furm your home videos into beautifil movies and Hollywood-style tral ers that you can share with afew quick clicks

Irmport a video.

Inngzort wideo from your iPhone, iPad, or iPod towch, from a camera, or from media files already onyou Mac iMovie creates a new ligrary and evertfor you.
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View your Correct and adjust Share a mavie,
projects. colorin your clip. trailer, or clip. |

Record video with the built-in camera.
Use the FaceT me HD camera on your Mac o record video and add it to your project. Select an event in tre sidekzar, dick bnportin the toolizar, select
FaceTime HD Camera, then dick the Record button to startand stop recordra,

Create Hd lywood-style trailers.

Make clever tralers, complete with animated graphics and soaring soundtradss, st add photos and video clips ard customize the oredits, To get started,
click the New button +,

click Trailer, choose a template from the Traler wirdow, then dick Create. Add the cast ard credits in the Outline taly, ard add your own photos and videos
inthe Storyooard tas.

Click Play to
preview the trailer.

FAIRGBALE

Cast Members: Any

Tip:
Shiooting video with a handheld dewice: can produce shaky results, But you can stabilizes thes video so the Hayiack is smoother. Seect the clip in the
timesline, dick the: Stabilization button &,
thermclick Stabilize Shaky Video.

Use the Touch Bar on your 13-inch MacBook Pro.

Tap o Favorite or Reject ary clip in the: browser, making it easy to find the dip later or hide itfromview, Youcan also fap inthe Touch Bartoplay a clip,
add a Clip 0 the clrrent Movie, of add aclip as a Yideo overay, SUCh as Split ScreBN or Sicture N 15 ciure,

When the imeline is selected, use the Touch Ba BULors 10 rewi nd, play, fast-forward, o 5alitthe dipirto two parts at e point where you ciick. Tap ihe
volume: button in the Cortrdl Strip to adjust the volume of a dip.

Use the slider o adj_st the volLme. When you finish, tap & .
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